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Web and mobile testing

Web testing and all different types of mobile testing represent an emerging field concerning
automated software testing. Ranorex offers a wide range of tools and methods to cover as
many test challenges as possible. They are all described herein.

m Web testing

@ Endpoints

E Mobile testing

E Android testing

m i0S testing




Web testing

This chapter describes how to test web applications and web sites using Ranorex Studio.
Thanks to the Ranorex plug-ins for Microsoft Internet Explorer, Mozilla Firefox, Google
Chrome, and Chromium, building and running web tests is essentially the same as doing so
for desktop tests. However, there are some differences and important considerations. We’ll
explain these in the various subchapters.

Supported browsers
Ranorex Studio supports the following browsers for test automation:

e Microsoft Internet Explorer

e Microsoft Edge (Chromium-based)
e Microsoft Edge (Legacy)

e Mozilla Firefox

e Google Chrome

e Chromium

Ranorex Studio uses special browser plug-ins to enable test automation with these browsers.

ﬁ Note

You can test even more platform and browser combinations with our >
Selenium WebDriver integration.

Web testing overview

Web testing and desktop testing in Ranorex Studio are very similar. The basic web testing
process in Ranorex Studio is as follows:

Select browser & URL ‘j{
a Record the web test ‘ﬂ/

Run the web test & check report ‘



https://www.ranorex.com/help/latest/interfaces-connectivity/selenium-webdriver-integration/
https://www.ranorex.com/help/latest/interfaces-connectivity/selenium-webdriver-integration/

@ Note

Web sites can have highly complex structures. This is why it may sometimes be
a good idea or even necessary to extend the above process by manually
tweaking the recorded test with additional code. We’ll cover this in the later
subchapters.

Recommended knowledge

Before you start web testing, you should be familiar with the basics of how web sites work.
You should also understand the concepts covered in the following Ranorex-Studio chapters:

Ranorex Studio fundamentals

The - Ranorex Studio Fundamentals contain the chapters dealing with all the basic elements
of working with Ranorex Studio, like actions, repositories, and reporting.

Ranorex Studio advanced and expert
For web testing, we recommend reading through the advanced chapters -+ RanoreXPath and

- Ranorex Spy. Also, knowing your way around - code modules and the - user code library
will be helpful when tweaking web tests with additional code.

Build a web test

In this chapter, you’ll learn how to build a simple web test from start to finish, including
recording the test, running it, and viewing the test run report.

Test definition
Our test will contain the following steps:

o Start the browser and open the URL www.ranorex.com/web-testing-examples/

9 Check if the Ranorex Studio logo is displayed at the top.


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/
https://www.ranorex.com/help/latest/ranorex-studio-advanced/ranorexpath/introduction/
https://www.ranorex.com/help/latest/ranorex-studio-advanced/ranorex-spy/introduction/
https://www.ranorex.com/help/latest/ranorex-studio-expert/code-modules/
https://www.ranorex.com/help/latest/ranorex-studio-expert/user-code-library/introduction/
http://www.ranorex.com/web-testing-examples/
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© Note

In automated tests, using the action Close application is usually more robust
than closing an application “manually” by clicking the X in the application
window. This is why the default web test project uses this action.

Create a new web test
We’ll create a new web test using the -» RocketStart wizard.

o On the Ranorex Studio Start Page, click New test solution using wizard... or go to
File > New > Solution using wizard...

9 Click Web.

e Follow the instructions of the wizard. Name your solution WebTest. When
prompted, select Mozilla Firefox as your browser (make sure it’s installed on your
computer) and specify www.ranorex.com/web-testing-examples/ as the URL.

¥ Rx Ranorex Studio & Kol Rarore. prodic

Welcome to Ranorex Studio 8
How do you want to start?

Start 2

B3 New test solution.. Web

B New test solution using wizard.. &

Recent projects Welcome to i

Ranorex Studio 8

When asked to select the recording behavior, select Add browsers to whitelist, as
our test will only cover interactions with the previously selected browser. If we
were going to interact with desktop applications and wanted this in our test, we’d
select Do not use whitelisting.

6 On the final screen, click Finish. Ranorex Studio will then open the prepared
solution.


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/ranorex-studio/creating-new-test-project/
http://www.ranorex.com/web-testing-examples/

N Creste your new solution *®

Select recording behavior

How do you want Ranorex Studio to behave while recording?

Add browsers to whitedist Do not use whitelisting

™

® Hint: Use the whitelisting feature of Ra 0 to add or modify entries later.

« Back Contanue »

The prebuilt web test will look like this:

E WebTest - Test suite

= El TestCase
. [SETUP]

Test suite view

This is where you build and control your tests.
The solution comes with a test suite project that contains a simple prebuilt test suite

EM CpenBrowser T
|t w— | EM Recordingd il
- \. - ; = [TEARDCOWN]
;E T EM CloseBrowser

Almost there

ik Create to create your

n and get started in Ranorex Studio

quide you ¢

5 Bach

Finish

RECORD L

€ Add new action -

i

z Action

structure. It contains a test case with three recording modules: OpenBrowser, which
starts the browser and navigates to the URL; Recordingl, which is empty and ready
for you to record test actions; and CloseBrowser, which closes the browser.

¢¥ Recording module view

In the recording module view of Recordingl, you can record and manage test

actions.



3| Empty actions table
This is where your recorded actions appear.

Record the test

Before you start recording, make sure Firefox is running and the URL www.ranorex.com/web-
testing-examples/ is opened. Don’t record these steps. They are already included in the
prebuilt project.

Once that’s done, you can start recording.

o In the recording module view, Click RECORD. Ranorex Studio is minimized.

9 The Recorder control panel appears in the bottom right.

K, Wekld - Ferwrs ke ¥

) P Image based recording @ Enable hotkeys @

FRe— [ r——

® RECORDING [+ validate | | Pause || Stop | @ Add

Validate the logo
o In the control panel, click Validate.

Ranorex Recorder (Shift+Esc to stop)

Ranorex Recorder (Shift+Esc to stop)

@ Image based recording ® Enable hotkeys

® RECORDING (& validate | [ Pause || [l Stop | € Add @ Image base a Enable hotkeys @

o VALIDATING & validate | @ Continue

Mouse over the Ranorex Studio logo and click it when the purple frame surrounds
it as in the screenshot.


http://www.ranorex.com/web-testing-examples/
http://www.ranorex.com/web-testing-examples/

Ranorex Recorder (Shift+ Esc to stop)

Ranorex Recorder (Shift+ Esc to stop)

@ Image based recording @ Enable hotkeys @

. Image based recarding . Enable hotkeys @

® RECORDING (& validate | [ Pause || [l Stop | € Add

o " VALIDATING & validate | @ Continue

and click Next to confirm.
The Validation settings open. We’re checking that the logo exists and is visible. Both
of these attributes should already be selected. Click OK to confirm.
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Open and confirm the dialog window

o In the browser, click Open dialog. A simple dialog window opens.
9 Click OK to confirm and close the dialog.



Ranorex Studio - Web example page

o Dpen dialog

‘ Link clicked!
o[ ]

9 Finally, in the Recorder control panel, click Stop to finish the recording.

Rancrex Recorder (Shift+Esc to stop)
3 E] Mouse Left
Mouse Left

1 B Validate AttributeEqual

@  Image based recording @ Enable hotkeys @

@ RECORDING ¥ validate || [} Pause B Stop | (3 dd

Results

The control panel disappears and Ranorex Studio comes back into focus, showing the
following:



B WebTest - Ranores Shudic

L 2 WebTest & Add new action = m ) % Turbo mode |[3gy Screenshot n_
i & Aeterenc .
= - # Action
:— :‘:1‘::::?_‘[5 . 1 Vahdate AttributeEqual Visible True < HeaderTop
i zi‘*“i‘”‘“"‘"" 62 Mouse Click Left Relative <2 OpenDislog
T —
[ Program.cs M3 Mouse Click Left Relative <3 SomePTag
+ M Rpcording l.m e
T WebTest.ncmg
W WekTestmts
[T WebTestRepositongrerep
e R €2 Add new item + & Track... [l 9 G | ] WebTestRepository = | = Variables...
@ WebTest Item Path
o = |@] ApplicationUnderTest Base: /dom[@domain="www.ranorex.com'’]
B4 Closelermser [l <@ HeaderTop Jidiv[# headertop’]
g;:;:muw ' lual Screenshoti
<2 OpenDialog Jidivi# Content’]//a[@innertext="0pen dialog’]
<2 SomePTag Jidivi# Content']/div[1]/p[3]
*

Action table with three recorded actions.

w2 Repository with repository items referencing the three Ul elements interacted with
during the recording.
Run the test and review the report
Let’s run the test and review the test run report.

o Close all instances of Firefox.

9 Click the tab WebTest.rxtst to switch to the test suite view and click RUN.
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Report

Once the test run has finished, the report will appear. In our case, it should look like this:

| 3 WebTest - Ranorex Stucko (Admenestratos) — o x |

= e %
=K Solution WebTest ~

Sohution Items. ¥ Rx Ranorex

= 8% WebTest
4 4 Feferences
W Faports
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[ Assemblyindo.cs WebTest
il EM ClozeBrowser.nuec

7 @M OpenBrowser.rirec
{3 Programecs
3 @M Recording.mrec
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B WebTest retst
+ & WebTestRepository.rxrep

Test case result summary

Expand test contaners Expand detailk  Collapse ¥l

est comtames filter ¥ Succe Vifsied  MiBlocked

| » 1 TestCase

A detailed view of the test case shows that all actions were executed successfully.



Test container filter: & Success |ﬂ Failed H“‘ oCKed

I v ] TestCase

I b SETUP

| » [EM Recording
Iter 2 o Z..
Time Level Category Message
00:02.339 Info Validation Validating AttributeEqual (Visible='True') on tem ‘ApplicationUnderTest HeaderTop
00:06.250 Success Validation Attribute 'Visible' of element for item "WebTestRepository. ApplicationUnderTest HeaderTop' does match the specified value
00:06.4 use e Applic i rT 4
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[+ o
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%"J Reference

Reports are explained in Ranorex Studio fundamentals > > Reporting

Website structure in Ranorex Studio

Ranorex Studio can recognize the entire HTML architecture of a website and make it available
for automated tests. Use Ranorex Spy to browse through a website’s structure and see how
it’s represented within Ranorex Studio. Websites are organized into three basic parts in Spy.
These are explained below.

Domain object model (DOM)

This is the top-level node. Each website opened in a browser has its own DOM node in Spy.


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/
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Browser in Spy showing five DOM nodes, each representing an individual website.

Browser-specific elements

Each browser also has browser-specific elements that aren’t contained in a DOM node. These
relate mostly to control elements and application windows, e.g.:

e Window controls (minimize, maximize, close)
e Pop-ups

e Dialog windows

These elements are organized in browser-specific FORM nodes.
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Tab control elements in a browser (note the website in the tab is still a DOM node).
Window controls in a browser.
Dialog window in a browser.

These elements are organized in browser-specific FORM nodes.
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& THACK Weairtasne] ¢ T - E & o, C aittan|
BRASER & RESULTS
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@ Note

Browser-specific elements can cause issues in cross-browser tests because
naturally, different browsers have different elements. They should either be
avoided or individualized in these cases.

You can handle browser-specific elements in the RanoreXPath or in code.

A RanoreXPath handling a button for two different browsers by way of their process names
would look as follows:

/form[@processname="'firefox' or
[@processname="chrome']//button[@text="0K"]

If you want to include more process names, the following is a more economical way of doing
so:

/form[@processname~"' [iexplore | IEXPLORE |chrome|firefox]'//button[Q@text=
VOKI]

The Ranorex Automation Library included in Ranorex Studio also makes it possible to
differentiate between browser-specific elements by way of various variables and methods in



code. For example, the variable BrowserName allows distinguishing between different
browsers. The following code example demonstrates this:

C#

if(webDocument.BrowserName == "IE")

{

Button okIE = "/form[@processname~'(iexplore|IEXPLORE)']//button[@text="0K"']";
okIE.Click();

}

else if(webDocument.BrowserName == "Mozilla")
{
Button okFF = "/form[@processname="firefox']//button[@text="0K"']";

okFF.Click();

}

else if(webDocument.BrowserName == "Chrome")

{

Button okChrome = "/form[@processname="'chrome']//button[@text="0K"']";

okChrome.Click();

}

else if(webDocument.BrowserName == "Safari")
{
Button okSafari = "/form[@processname="'Safari']//button[@text="0K"']";

okSafari.Click();

}




If webDocument.BrowserName = "IE" Then

okIE As Button = "/form[@processname~'(iexplore|IEXPLORE)']//button[@text="0K

I]ll
okIE.Click()

ElseIf webDocument.BrowserName = "Mozilla" Then
okFF As Button = "/form[@processname="firefox']//button[@text="0K"']"
okFF.Click()

End If

ElseIf webDocument.BrowserName = "Chrome" Then
okChrome As Button = "/form[@processname='chrome"']//button[@text="0K"]"
okChrome.Click()

End If

ElseIf webDocument.BrowserName = “Safari"” Then
okSafari As Button = "/form[@processname='Safari']//button[@text="0K"]"
okSafari.Click()

End If

The WebDocument class and its variables and methods are described in the Ranorex API
documentation under Ranorex > WebDocument.



http://www.ranorex.com/Documentation/Ranorex
http://www.ranorex.com/Documentation/Ranorex

Website elements

Website elements are targeted using -» RanoreXPath, just like elements in a desktop
application. The element browser in Spy displays this as follows:

- '\:; Dropbox

&« c @

Get Dropbox Basic

dropboccom wen : fin,

O

m X

22 Dropbox - Sign

in

% Editeg ' ApplicationUinderTest Signin'

ELEMENT
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SER

\
—
' i
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CROS VE - Edit Mode A Sign in”
B@ Dom Dropbox’ .
= <» Body o
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E|<E| Div'supernav__section’ -
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- < Li'supernav__list-item’
o U demant Toune L2

In the repository, identified website elements are referenced as repository items and

displayed as follows:
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<3, JohnPublic
@ McPopoverTrigger

Jimaw T idivydiv[1)/div[@innertext="John Public]
Ibutton



https://www.ranorex.com/help/latest/ranorex-studio-advanced/ranorexpath/introduction/

Advanced web testing

In this chapter, we’ll cover some advanced topics regarding web testing.
Use the Wait for action to wait until an element has loaded

Loading times that take longer than usual are a common issue in web tests. They can cause
tests to fail and can get quite annoying, as they are often outside of the tester’s control. One
way to work around these loading times is by instructing the test to wait until a certain
element has loaded. In Ranorex Studio, you can easily do so with the Wait for action.

° In the action table, add a Wait for action after an action that loads a web page and
before an action that manipulates an element on the loaded page.

3 Wiebest - Ranores Sudio o

Bile  Edt  Yiew Pooject Eyid [ebug
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@~ BB = BEG&0 > £ (L X 5 vewkiypod ~ O
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N (O] Wait for Exists 10s @ ApplicaticnlUnderTest

ro &2 Validate Containslmage Screenshot] <% HeaderTop

= S Mouse Click Left Relative €2 CpenDialeg

104 Mouse Click Left Relative < SomePTag
i BT YRITEE
Add e ilemn - B Tiek. | 3 O& 9 E | I WebTestRepasbary = Veriablei.. o Cleasup i a-
I E @ ApplicationUnderTest R R B Fiase: /dom[@domain="www.ranorex.com’]
S o e e

Wait for action with 10s waiting time. The action waits until the linked repository
item exists. This should be the repository item that is manipulated in the following
action.

The repository item that the action waits for to exist.

© Note

Your test can still fail if loading takes longer than the time set in the Wait for
action and the repository item doesn’t exist. Choose a sensible time value that
prevents failure because of insignificant loading delays and doesn’t keep your
test searching for an element for too long.




© Note

Instead of the Wait for action, you can also use the Delay action to pause your
test run.

However, the Delay action always pauses the test run for the specified time,
regardless of an element existing or not. This is why you should use the Wait for
action if there is a repository item you can sensibly link it to. This way, your test
won’t idle unnecessarily.

Use the Set value action to enter values more robustly

Entering values like text strings in web forms is a common scenario in web tests. This can
either be accomplished by simulating the keypresses on a keyboard (Key sequence action) or
by directly setting the form to a specific value. The latter is usually more robust because no
mouse clicks or similar are required, so there is less potential for failure. Conversely, this can
cause the test to miss certain defects because you deviate farther from a true user

experience.
Test situation

In our example, we’ll enter a name in the sample form on the Ranorex test website. The
process is as follows:

o Enter the name in the text field of the form.
9 Click Submit to submit the name.

The page that appears as a result.
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Set value action that enters the name in the text field.
Repository item Testname that represents the text field.

Result

The value is set directly in the form without any mouse clicks or typing.
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For more details on the Set value action, refer to Ranorex Studio fundamentals >
Actions > - Action properties.
Use the Get value action to read out values for use in the test

It’s often useful or necessary to read out values on websites (numbers, strings, etc.) and use
them further along in the test. The simplest way to do this is with the Get value action.

Test situation

In our example, we’ll read out a list value to reuse it in the sample form on the Ranorex test
website.

With the default values selected, clicking the Submit button produces the following result:
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Color/testcolor is set to green.
Colors/testmultiple is set to green and yellow.
We’ll now

e getthevalue blue from the testmultiple parameter and
e setthe testcolor parameter to this read-out value.
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the variable S$Color.

Color/testcolor to it.
Result

The resulting page will look like this:
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The Get value action reads out the value blue from the Colors field and passes it to

The Set value action uses the value of the variable $Color and sets the field

The field testcolor now has the value blue, as set by the Set value action.

out the value blue.

The testmultiple field is still set to the default values. The Get value action only reads
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For more details on the Get value action, refer to Ranorex Studio fundamentals >
Actions > -» Action properties.

WebDocument Adapter

The WebDocument Adapter creates a representation of the complete website including all
tags (e.g. the header tag, body tag, etc.). Furthermore it offers useful ways to make your test
scripts more effective.

The following sample shows how to use these features:

C#

WebDocument webDocument = "/dom[@caption="'Ranorex Test Page']";

webDocument.Navigate("http://www.ranorex.com");

webDocument.WaitForDocumentLoaded();

webDocument.ExecuteScript("history.back();");

VB.NET

webDocument As WebDocument = "/dom[@caption='Ranorex Test Page']"

webDocument.Navigate("http://www.ranorex.com")
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webDocument .WaitForDocumentLoaded()

webDocument.ExecuteScript("history.back();")

Find or filter web elements

The Ranorex Framework offers a wide range of adapters for each HTML tag elements (e.g.:
ATag adapter for <a>tags). Each adapter has specific methods and attributes; the link tag
(<a>) for example has additional attributes like HREF, TARGET and REL.

C#

System.Diagnostics.Process.Start("iexplore.exe", "/web-testing-examples");

WebDocument webDocument = "/dom[@caption='Ranorex Test Page']";

ATag link = webDocument.FindSingle(".//a[@innertext="simple link']");

link.Click();

VB.NET

System.Diagnostics.Process.Start("iexplore.exe", "/web-testing-examples")

webDocument As WebDocument = "/dom[@caption='Ranorex Test Page']"

link As ATag = webDocument.FindSingle(".//a[@innertext="simple link']")

link.Click()




Repositories and the WebDocument

The following example shows how to access the methods of the WebDocument using a
repository:

C#

ProjectRepository repo = ProjectRepository.Instance;

repo.WebPage.Self.Navigate("http://www.ranorex.com");

repo.WebPage.Self.WaitForDocumentLoaded();

VB.NET

repo As ProjectRepository = ProjectRepository.Instance

repo.WebPage.Self.Navigate("http://www.ranorex.com")

repo.WebPage.Self.WaitForDocumentLoaded()

Cross-browser testing

Cross-browser testing involves executing one test across multiple browsers. This can save a
lot of time and reduce maintenance efforts, but it comes with its own challenges. In this
chapter, we’ll go through a cross-browser example step by step.

Test scenario

We want to use Ranorex Studio to test a specific scenario on three different browsers:
Microsoft Internet Explorer, Google Chrome, and Mozilla Firefox. We want to accomplish this
with only one test that works for all these browsers.



To demonstrate our cross-browser example, we’ll use a free Dropbox account. Dropbox is a
registered trademark of Dropbox, Inc. and Dropbox International Unlimited Company. Their

terms of services and privacy policy apply. Ranorex GmbH, Ranorex, Inc. and Dropbox, Inc.
are not affiliated in any way.

@ Note

You will need to create your own free Dropbox account for this example.

Our test will go through four steps that are defined as follows:

Start
o Start the browser and go to the URL www.dropbox.com

9 Click Sign in to reach the sign-in page.

- 1
‘ u hitps://www.dropbox.com

Sign-in
9 Enter e-mail address and password.
9 Uncheck the option Remember me.

e Click Signiin.
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Check account

Here, we’ll check if we’re signed in to the correct account. There are different ways to do this.
In our example, we’ll click our account picture and validate the account name.

6 Click the account picture to open the account menu.

Check if the displayed account name is the same as that of our fictional person (John
Public, in our case).

N ) i@ Do ine 1S PR—— wox =

2 Home - :é @
o :- a ohn Public 0

Change photo

0 bytes of 2 GB used
Upgrade

Settings

Install

Sign out
e Click the account picture to open the account menu (if it isn’t still open).

e Click Sign out.
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Create a new web test

To get started, first create a new web test as explained in - Build a web test and keep the
following in mind:

e Give your solution a meaningful name (e.g. CrossBrowserTest).

e Enter www.dropbox.com when asked for the URL.

e You’llonly be able to select one browser in the wizard. This is fine, choose Firefox.
We’ll extend the test to the other browsers later.

e When asked to select the recording behavior, select Add browsers to whitelist.

e Click Finish. The new test solution appears.

Before recording

We'll first record our web test on a single browser. Later, we’ll adapt it to work across multiple
browsers.

Before we start recording, we’ll need to make the following preparations (if you’ve instructed
the wizard to start the browsers automatically, you can skip this).

o Start Firefox.

9 Go to www.dropbox.com
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Record the test

o Open the Recordingl module. Click RECORD.

Image based recording @ Enable hotkeys @

RECORDING [< validate || || Pause || [ Stop || € Add

Click Sign in.

Uncheck Remember me.

Click Signin.

2,
e Enter your e-mail address and password.
(4]
©

6 Wait until the page has loaded and click the account picture.

Validation

Here we’ll insert a -» validation to check whether we’re logged in to the right account. We’ll
do this by validating the account name, John Public in our case.

o In the Recorder control panel, click Validate.
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Mouse over the account name in the account menu. A purple frame will indicate
which element is currently selected. Click to confirm the selection.
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correct the selection. Click Next to confirm.
Make sure the attributes Exists and InnerText with the account name are checked.

e In the window that opens, check if the correct element has been selected. If not,
e Click OK to confirm.
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Finish the recording

After the validation is configured, Ranorex Studio will continue recording. It’s time to finish
the recording.

° In the opened account menu, click Sign out.
9 Click Stop in the Recorder control panel to finish the recording.

Result

After stopping the recording, you’ll be returned to Ranorex Studio, with the resulting
recording being displayed. Let’s take a look at this initial version of our cross-browser test.
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Action table showing 11 actions (your recording may differ slightly in the amount of

|
actions).

Repository with 8 repository items organized into two folders.

Optimize test for cross-browser adaptation
Before we start turning the test into a cross-browser test, we should optimize it.

Combine key sequences

Sometimes Ranorex Studio will split key sequences. This can happen because the sequence
wasn’t entered fast enough, for example. You should combine key sequences wherever it
makes sense.

o Select the key sequences you want to combine and open the context menu.

9 Click Merge selected keyboard items.
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Optimize key sequence content

Key sequence
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Sometimes, entering special characters can result in unnecessarily complex strings. Simply

correct them manually in the action table.

In the example below, we simply replaced the superfluous keypresses with @.

[ s TIUSE LI
Bz Key sequence JjehndBpublic{L ControlKey down}{RMenu down}{ Qkey {LControlKey up{RMenu upHLControlKey upjgmail.com
G4 Mouse Chick |
Es Key sequence
MA houes Click @2z Mouse | Click Left Relative
EH 3 Key sequence “—s| jochnd3public@gmail.com
T a [ Faad 1P - Doalabicsn




Unoptimized
Optimized

Find and replace dynamic identifiers

Many applications contain so-called dynamic Ul elements. These changes whenever a
particular event happens, e.g. when you reload a web page. It’s often harder for automated
testing tools to find these Ul elements reliably. This is because identifiers that are robust for
static Ul elements (like the element ID) change all the time for dynamic Ul elements. This is
why you need to fall back on other identifiers for dynamic Ul elements.

For web elements, Ranorex Studio uses an intelligent algorithm that recognizes when a Ul
element is dynamic. Itignores dynamic identifiers and uses a robust, static identifier instead.
This means you should normally not need to find and replace dynamic identifiers from your
repository items. However, in some cases a dynamic identifier may be missed and you’ll have
to replace it by hand.

Dynamic identifiers usually appear in the RanoreXPath with a name prefix and a long

character string that changes whenever the element is loaded (see paths marked in red in
image).

-
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Replacing dynamic identifiers with more robust ones is explained in Ranorex Studio
expert > -» Mapping dynamic Ul-Elements.
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In our example, the improved repository looks like this:
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In automated testing, it’s a good idea to make sure text fields are empty before something is
entered in them.

) Add new action - M £ Zk Turbo mode | fgg Screenshot
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The four actions in the image represent entering the e-mail address into the text field
represented by the repository item LoginEmail.

Click into the text field.

Press Ctrl + A to select any existing text in the field.

Press Delete to delete the text.

Enter the e-mail address.

If the text field is already empty, actions 2 and 3 won’t have any effect. The test will continue
without issue. Alternatively, you can also use the Set value action to replace all of these four
actions or just the actions for emptying the text field.

Structure your test

Your tests should always be well structured. This is why you should organize your actions into
various recording modules and structure them in the test suite.
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Organizing recording modules is described in

Ranorex Studio fundamentals > Ranorex Recorder > > Manage recording modules.

Structuring test suites is explained in

Ranorex Studio fundamentals > Test suite > -» Test suite structure.

In our example, we’ve organized the recorded actions into the following modules and

structured the test suite as seen below:

) Data source...

[tem
i CrossBrowserTest - Test suite
= E| TestCase
-] [SETUP]
EM CpenBrowser

EM Signin
EM Login
EM VerifyAccount

EM SignCut

| [TEARDCWN]

EM CloseBrowser

Data binding / iterations

Setup region containing the module for starting the browser and opening the URL.

Four recording modules to go to the sign in page, sign into Dropbox, check the

account, and log out.

Teardown region containing the module for closing the browser.

Cross-browser functionality

Now that we’ve optimized the test, we can implement the cross-browser functionality.

Cross-browser testing is based on data-driven testing and variables.
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These topics are described in
Ranorex Studio advanced > -» Data-driven testing

Ranorex Studio advanced > - Variables and parameters.

Make the browser type a variable

As a first step, we need to replace the fixed browser in our OpenBrowser.rxrec module with a
variable. This variable will take on the different browsers as value during the test run.

o Open the drop-down menu for the Browser property and click As new variable...
9 Enter a name for the variable, e.g. selectBrowser, and click OK.
e The browser type is now a variable in the actions table.
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Chromium III Cancel
Edage
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RECORD e RUN
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Create the data source containing the browsers

In this step, we’ll create a data source to provide values to the browser type variable.

o Open the context menu of the test case in the test suite view.
9 Click Data source...
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Data binding / iterations

Unbound variable: 1

Description

Run selected test case

Run to here (excl. selection)

Data source... e ‘

Data binding...

Condition...
Add »

Add setup
Add teardown

values in the image below.
Click OK.

© 00

TestCase properties

Bl TestCase

General Datasource Data binding Condition
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- | I Manage data sources... I

Browser Add column..
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1]/ IE
4 oW

Data ramge
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QK

Refresh
Preview effective data set... |
Cancd | || Apply

Click New > Simple data table and enter a name for the table, e.g. BrowserList.

Use the Add column... and Add row... buttons to create the table and fill it with the
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Creating data sources is explained in

Ranorex Studio advanced > Data-driven testing > - Data and data management.

Binding the data to the variable

° Open the context menu of the test case in the test suite view.

9 Click Data binding...

CrossBrowserTest.ndst™ X

TestRun v . Maintenance mode

- 4N v [® Data source...
ltem Data binding / Iterations Description
Mg CrossBrowserTest - Test suite
= S TestCase S P, Run selected test case
& BER P, Runto here (excl. selection)
EM OpenBrowser Unbound vanable: 1
BM Signin f®  Data source...
B Login | Databinding.. 9 |
B VerifyAccount @ Condition..,
EM SignOut Q Add »
=] [TEARDCOWN] Add setup
Ed CloseBrowser Add teardown

Under Variable binding > Module variable, select the variable
OpenBrowser.selectBrowser from the drop-down menu to bind it to the Browser
column of the data source.

Click OK.

L~ I
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General Data source Detabinding  Condition
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[ Add row... | -

Auto-create Aute-bind Clear bindings

o Cancel Apply
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Data binding is described in Ranorex Studio advanced > Data-driven testing > - Data
binding.

Run the cross-browser test

The final cross-browser tests should look as follows in the test suite:

CrossBrowserTest.ndst

L] Data source...

Item Data binding / iterations
E CrossBrowserTest - Test suite
Elm TestCase Browserlist = Rows: 3
G- [SETUP]
31 OpenBrowser Bound variable: 1
EM Signin
EM Login
EM VerifyAccount
EM SignOut
= [TEARDOWN]

‘- [EM CloseBrowser
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Test suite structure with a test case containing setup/teardown regions and
modules.
The test case contains a data source called BrowserList with 3 rows of data.

The module OpenBrowser contains one variable that is bound to a data source.

Results

After the test run, the report should look as follows:

CrossBrowserTest.ndst | CrossBirowserTest 2018101006223 1 ndog 3¢

»
¥ Rx Ranorex

CrossBrowserTest

Test case result summary

‘

Three test cases were completed successfully.

Expand test contaners Expand details Collapse all

Test container filter: I Succes AFaded MiBlocked

|I » [ TestCase 3 |

w2 Oursingle test case was iterated three times, once for each row in the data source,
i.e. once for each browser. Hence, three successful test cases.

Bringing up the details of the OpenBrowser module for an iteration shows the value passed
to the variable:

I * a4 TestCams

| * [ TestCase 1

- [ CperBrowser

=l

Time Lewel Coimgory Messsge




-
9 Reference

Reports are explained in Ranorex Studio fundamentals > - Reporting.

Download the sample solution
You can download the completed sample solution file from the link below:

Sample Cross Browser Test

A\ Attention
The recording module Login.rxrec does not contain any login data. Fillin
your own Dropbox account data. You will also need to change the content of
the Validation attribute InnerText to your own account name in the
recording module VerifyAccount.rxrec.

Install the sample solution:

o Unzip to any folder on your computer.

9 Start Ranorex Studio and open the solution file CrossBrowserTest .rxsln

Hint

The sample solution is available for Ranorex versions 8.3 or higher. You must
agree to the automatic solution upgrade for later versions.


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/reporting/introduction/
https://www.ranorex.com/rx-media/rx-user-guide/latest/download/RxSampleCrossBrowserTest.zip

Endpoints

Endpoints are the gateways through which a locally executed test exchanges data with an
external AUT. In simpler words, they allow you to test an external application or system as if it
were on your machine.

Manage endpoints
Endpoints that have been added to Ranorex Studio are displayed and managed in the

Endpoints pad. Click the endpoints symbol in the menu bar to bring up the Endpoints pad. By
default, it appears on the right edge of the screen.

REtpags X

’.Rx Ranorex Studio 8

Weslcame to Fanal

Endpoints

Endpoints

Sart

=P

Release Highlight

B Cpen fest soluton..

No endpol
Recent projects Ranorex Announcements

Sampe prajects Less Britthe GUI Test Automation 17

PMaster benkine |r||-_.;|.,|,'.;m

o Empty Endpoints pad.
9 Endpoints pad displaying the endpoint list with three endpoints.

Endpoint list
If your endpoint list is empty, you’ll see a corresponding message and a button to add an

endpoint. If you’ve already added at least one endpoint, the endpoint list will appear as
follows:



Endpoints

Endpoints

[~

RXLAPTOPO20
Localhost
Microsoft Windows 10 Pro

@

Meoous 5X

) el

RX iPad
2514dd96649409022113a%cabeldsfchSecibd

(]

Refresh and Add endpoint buttons.

Search field for endpoints.

Click to access this endpoint’s settings.

Endpoint name

Connection status (Connected/Error/Connecting...)

Endpoint ID: IP number for network connections, ID for USB connections.

Automation root status symbol (explained in -» Endpoint settings)

2|~]olalaoln]

Endpoint type (Android, iOS, WebDriver)

Shortcuts and command line execution

Aside from the usual test executable, the /output/ folder also contains shortcuts for each
endpoint. These shortcuts allow you to execute the test directly on a specific endpoint. The
endpointis represented in the shortcut’s file name as @<endpoint>.


https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/endpoint-settings/

[55] AndroidAppTest.exe Application 20 KB

| AndroidAppTest.exe.config XML Configuratio... 1KB

|j AndroidAppTest.pdb PDE File 32 KB

E.'-J AndroidAppTest.rtmg Ranorex Test Suite 1KB

Androidfpp Test.ndst Ranorex Test Suite 3 KB -
I_'% AndroidAppTest@USE-00c18ccf5e6b3T03 Shortcut 2KB :“muraticn File

|%| Ranerex.Core.Resclver.dll Application extens 206 KB |
i S rowrile
B i0SAppTesting.ntmg Ranorex Test Suite
B i05AppTesting.ndst Ranorex Test Suite
72 i0SAppTesting@RX iPad Shortcut
| Ranorex.Core.Resclver.dll Application extension

Shortcut for an Android endpoint.
Shortcut for an iOS endpoint.

=)
—
Reference

You can also manually trigger test runs on endpoints through the command line. The
required arguments are listed in Ranorex Studio fundamentals > Test suite > > Run
tests without Ranorex Studio.

Endpoint settings

In this chapter, we’ll explain the available settings for endpoints.

@ Note

Most of the settings explained here are valid for Android, iOS, and WebDriver
endpoints. WebDriver endpoints have some additional, more complex settings
that we explain separately in —» Add a WebDriver endpoint.

Endpoint settings

Click the button to the right of an endpoint to bring up its settings.


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/test-suite/running-tests-without-ranorex-studio/
https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/test-suite/running-tests-without-ranorex-studio/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/adding-webdriver-endpoint/

RELAPTOPDZ20
Localhost
Microsoft Windows 10 Pro

Mexus 5%
10.0.0.8

Set as automation root
View details

RX iPad

2514dd96649409:02211 Ja%acabelB3fcb9eelbd Instrument & deploy App

Save ADE log

= Jow o]

Refresh

&=

Edit
Delet

Set as automation root

Click to set an endpoint as the automation root.

This means that tests will only be able to interact with this endpoint and will receive
and send all data for test execution through this endpoint.

To reflect this, the run buttons in the Ranorex Studio toolbar and the test
suite/recorder view will change accordingly. You can also set an endpoint as the
automation root by clicking the symbol to its left in the endpoint list.

USB-00c18ccfiebb3T03
00c18ccf3ebb3T03

USE-00c18ccf3ebb3T03
00c18ccf5e6b3703

View details - Displays a detailed view of the endpoint’s properties:

Connection status and type



e Endpointname

e Ranorex Service (version of the Ranorex Service App)

e OS of the mobile device (Android/iOS only)

e Address

e Instrumented apps (Android/iOS only. Click the symbol next to an app to startit on
the device. Click the rocket button to - instrument and deploy an app to the
device).

Instrument and deploy app (Android/iOS only)

e Clickto -» instrument and deploy an app to the mobile device.
e Opensthe - Ranorex Instrumentation Wizard.

n Save ADB log (Android only)
e Savesthe log file of the Android debug bridge.

Refresh/Edit/Delete - self-explanatory

A Attention

Be careful when editing the endpoint’s address. A wrong address will result in a
connection error and test failure.

Add an Android/iOS endpoint

In this chapter, you’ll learn how to add an Android or iOS endpoint.
-» Adding a WebDriver endpoint is explained separately.

Preparation

ﬁ Note

Make sure you have applied the required - device settings to your mobile
device.



https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/interfaces-connectivity/instrumentation-wizard/getting-started/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/adding-webdriver-endpoint/
https://www.ranorex.com/help/v8.3/web-mobile-testing/mobile-testing-2/prepare-your-device/

o Turn on your mobile device and connect it to a power source.

9 Start the Ranorex Service App.

e Connect the device to your computer via USB (recommended) or WiFi (same
network as computer).

Add endpoint

° Open the endpoint list.

]
Stat page X

Endpoints

™
’R: Ranarex Studio 8

Endpoints
Wieleame te Ranares 5

Start

Release Highlight

5 Fiow temt acistinn

i open et soiuson..

Recent projects Ranorex Announcements

Less Britthe GUI Test Ausomation 1/,

An empty endpoint list.

Endpoint list with Localhost (the computer) and two endpoints added.

9 In an empty endpoint list, click Add endpoint. Or, in a list of existing
endpoints, click +.



Erdpeants

Endpainli

Endpints

Cheskitop

T

Anadroid

Mo endpoints added

Add endpoint

Select the OS of your mobile device and then select your device from the list below.
You can also enter the device’s address manually by clicking Other device...
o Click Add endpoint.

Back Add endpoint

1 Select emdpoind type
& Android

3 Select Android device

Mesous 5

c

4 Add endgioing




© Note

If your device doesn’t appear in the list, refresh it and make sure all required -
device settings have been applied.

Click Complete setup to return to the endpoint list or Add another endpoint. In
either case, the newly-added endpoint appears in the endpoint list.

4 Complete setup

Endpoints
Endpeint successfully added

Add anather endpomt Complete setup

RXLAPTOPO20
Localho
Microsoft Windows 10 Pro

Nexus 5X

RX iPad
2514dd96649409:022113a% cabeli3fcbeedbd

Add a WebDriver endpoint

In this chapter, you’ll learn how to add and configure WebDriver endpoints.
Preparation
Set up a WebDriver infrastructure, start the server, and note its address.
Ranorex Studio supports Selenium and Appium through WebDriver endpoints.
Selenium WebDriver
e Setting up a Selenium infrastructure is covered in - Selenium WebDriver integration.

Appium WebDriver

e OnAppium, Ranorex Studio currently supports only mobile web tests.


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/prepare-your-device/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/prepare-your-device/
https://www.ranorex.com/help/latest/interfaces-connectivity/selenium-webdriver-integration/

For help with setting up an Appium infrastructure, please refer to the official Appium
documentation.

Also, make sure you set the command timeout to at least 30 seconds in the - plugin
settings for WebDriver.

Add an endpoint for WebDriver

o Open the endpoint list.

Sawt page X

Endipoints

»
' Ry Ranorex Studio 8

Endpoints
Welcame to Ranares

Start

Release Highlight

B} e bl whitmn
B Cpen e solubon..

Recent projects

Iaster benkire intagration

An empty endpoint list.

Endpoint list with Localhost (the computer) and two additional endpoints.

9 In an empty endpoint list, click Add endpoint. Or, in list that is not empty, click +.


http://appium.io/docs/en/about-appium/intro/
http://appium.io/docs/en/about-appium/intro/
https://www.ranorex.com/help/latest/ranorex-studio-system-details/settings-configuration/plugin-specific-settings/
https://www.ranorex.com/help/latest/ranorex-studio-system-details/settings-configuration/plugin-specific-settings/

Endpints
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Mo endpoints added

Add endpoint
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e Select WebDriver.
e Enter a name for this endpoint.
6 Enter the server address.

© Note

In a default Selenium environment, you must add /wd/hub to the URL or IP
address of your Selenium server. Only change or omit this path if you have set up
your Selenium infrastructure differently.




Endpoints

Back Add endpaoint

1 Select endgoint type
Android
i

o WebDriver

2 Specity WebDviver endpaint ?

Pleaze choose an endpoant name for the Selenium / Apprm server you
wart to add and provide it address.

Endipoint nanmse

MySelenium
Address
http://localhost: 4444 /wd/hub

Click Test connection to see if a connection can be established. If the test fails,
check that your server address is correct and that the server is running.
o Click Add endpoint and Complete setup.

b

o [ ]

Add endpoint

4) Complete setup

Endpoint successfully added

Complete setup

e The new WebDriver endpoint appears in the endpoint list.



Endpoints

Endpoints

Desktop
RXLAPTOPO20

IE: D Localhost

Microsoft Windows 10 Pro

WebDriver

— MySelenium
[sa| http:/flocalhost4444/wd/hub

Add an endpoint configuration to a WebDriver endpoint

Endpoint configurations allow you to tell a Selenium WebDriver endpoint how to behave
during test execution. Selenium calls these characteristics of an endpoint capabilities. Most
commonly, they define what OS, browser, and browser version the WebDriver endpoint
simulates. In Ranorex, the sum of all capabilities defined for an endpoint is called an endpoint
configuration.

Endpoint configurations make it possible to easily execute tests in a Selenium grid on
multiple different system configurations without actually needing to have any of these
systems present.

To add a configuration to an endpoint:

o Click the symbol to the right of a Selenium WebDriver endpoint.
9 Click View details.

Endipeimiits

Desktop
e ELAPTOPO0

'_—

L2

khicroscét Windows 10 Pro

Wb e

. Moy Sl enaum.
Sg hitped fbocal heorst 4824 v, Fiu b



https://www.seleniumhq.org/docs/07_selenium_grid.jsp

e Click Add new configuration.

Endpoints

Back MySelenium

Endpoint information:
Status:
Endpoint name: MySelenium

Address: hitp://localhost:4444,/wd/hub

Currently running browsers

Open URL in...

Endpoint configurations Add new configuration

Active configuration:

Available configurations

Specify the endpoint configuration

Enter a name.

Enter a description (optional).

000

Endpoint information showing name, connection status, and server address.

List of currently running browsers with browser name and URL.

Enter the configuration, i.e. the capabilities definition, as JSON.
Make sure it conforms to the requirements of your Selenium Grid provider. Selenium

provides a list of capabilities. In the screenshot, the capabilities JSON conforms to

the requirements for Sauce Labs.


https://github.com/SeleniumHQ/selenium/wiki/DesiredCapabilities

Endpoint configuration

MName
ik

Firefox 62.0

Description
Configuration for Firefox 62 9

Capabilities JSON

"usernam public”,
"

ﬁ Note

If you are unfamiliar with JSON, use the Ranorex Studio - capabilities
configurator. Simply select your capabilities and provider and let the
configurator put together the JSON. Then, just paste the JSON into the
Capabilities JSON box of the endpoint.

e Click Save to confirm. The configuration appears in the endpoint details.

Enclpoing informuation:
Status:
Endpoint name: MySelenium
&ddress: hitpefocathostdddd S hub

Currantly susmning browsers

Open URL #- .

Enclpeing configunilices Beald e Cerdigiaation

Actve conligunation:

Available configurations

Firefox 62.0



https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/capabilities-configurator/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/capabilities-configurator/

Capabilities configurator

The capabilities configurator lets you generate your capabilities as a JSON in an easy and
straightforward way.

Simply select your desired options in the fields below. If you want to connect to a service like
Saucelabs, select the appropriate option and then replace the placeholders in the JSON with
your credentials.

Finally, copy the generated JSON and paste it into the ‘Capabilities JSON’ text box of your
configuration in Ranorex Studio.

Platform

| -

= e 4 O
Windows Mac Linux  Appium/Mobile

Select the platform you want your test to run on. Currently, PC and Mac systems are supported.

Operating System

Select Operating System "
Browser
Select Browser W

Browser Version

Select Browser Version w
Provider
Select Provider W

Some providers require specially formatted credentials for logins. Replace the placeholder with your actual
data when pasting the JSON into your application.



Your JSON WebDriver configuration

Copy to clipboard | and paste this snippet into the configuration text area in Ranorex Studio

Ranorex Parallel Runner

Ranorex Parallel Runner is a command-line tool that allows you to run a test across multiple
capability sets on a Selenium Grid through a WebDriver endpoint in parallel. The tool reads
the capability sets from an Excel template file.

Using Ranorex Parallel Runner

This tool is located in the Bin folder of your Ranorex installation. By default, this is
C:\Program Files (x86)\Ranorex\Bin\Ranorex.ParallelRunner.exe

It’s a good idea to run the tool with -help for the first time to display all available arguments:



B8 Command Prompt - O X

= 'arallelRunner
11el Runn
Ra

d in parallel for

i, --json n combin ith ori h i11 e yed in JSON

.ParallelRunner.exe Fi > -e <endpoint> [-o0
.P 11 r.exe
.ParallelRunner.

am File

Under the Usage: header, the three different use cases for the tool and the required
arguments are listed.

Ranorex.ParallelRunner.exe -c []

To get started, you’ll need to specify a set of capabilities. To do so, use this argument to
create the required Excel template. You can specify a location and filename if desired. By
default, the file will be created in the Bin folder and called CapabilitiesMatrix.xlsx. Follow
the instructions in the Excel file and define your capabilities.

Ranorex.ParallelRunner.exe -t -m -e [-o ]

Use this argument pattern to run your test with the defined capability sets on the specified

WebDriver endpoint in parallel. The -0 argument is optional. If you don’t specify a path, the
Parallel Runner will generate a folder called parallelRuns in the folder where the test suite

executable is located.

Ranorex.ParallelRunner.exe -m -p [-7J]

Use this argument pattern to permutate an Excel template file and display all the
configurations resulting from the capability sets defined in the Excel file. The -j argument is
optional and transforms the output into JSON which can be entered in the Capabilities JSON
text box of a -»WebDriver endpoint’s configuration in Ranorex Studio.


file:///C:/Users/Alejandra%20Barrientos/Desktop/Ale%20Barrientos/Ranorex/4.%20Web%20and%20Mobile%20Testing/2.%20endpoints/adding-webdriver-endpoint/index.html

Mobile Testing

In this chapter, you’ll learn how to test apps and websites on mobile devices including
smartphones and tablets. You’ll learn how to connect devices to Ranorex Studio, instrument
apps, and create and run automated mobile tests.

System requirements

Supported devices

Ranorex Studio supports Android and iOS mobile devices.

Connection

Mobile testing requires that you connect your device to the computer that Ranorex Studio is
installed on. You can do so by USB (recommended) or WiFi.

@ Note

Ranorex iOS implementation requires that ports 31000 TCP and 31000 UDP
must be open on your computer.

Additionally, Ranorex Android requires other ports above 31000 TCP; therefore,
enable ports up to 31020.

On some Android devices, such as Huawei, ports 31000 - 31900 are already
used. However, the RxService application chooses the next available ports,
which are detailed in a message after the RxServices installation. Make sure to
open these ports on your computer and correctly configured the Endpoints in
Ranorex Studio for Discovery and Device port fields.

' Rx Ranorex

o-%» »
=




Use the correct automation libraries for mobile testing

Test automation of Android/iOS apps is based on the Ranorex automation libraries for mobile
testing. To ensure automation works smoothly, always use the automation libraries that
correspond to your currently installed version of Ranorex Studio. Otherwise, you will receive
technology limitation warnings or even errors.

You can download the automation libraries for the different Ranorex Studio versions from the
mobile download archive.

If you absolutely must use earlier automation libraries, you can do so as long as they only
produce warnings, but this is not recommended. In this case, simply close the technology
limitation warning.

The basic procedure of mobile testing

Mobile tests in Ranorex Studio always follow the same basic procedure, regardless of the type

of device. The mobile OS and the type of test (app test or mobile web test) then determine the
specific actions and settings in the steps this basic procedure entails.

Device settings D D s

Connecting mobile devices <

Instrumenting mobile apps

- . . ] | Tap-Track-Add |5 ) \ )
Creating tests for mobile devices "3/ Drag Drop-Define

Running tests & reports

e'al

Prepare your device

e Enter the recommended device settings for Android and iOS
e Install the Ranorex Service App


https://www.ranorex.com/mobile-download-archive/

Connect your device

e Choose a connection type
e Add the device as an endpoint in Ranorex Studio

Instrument apps

e Pre-instrumented Ranorex web browser (Android, iOS)
e Instrument Android apps

e InstrumentiOS apps

e Pre-instrumented iOS sample app

Create a mobile test
e Create a solution for mobile testing
e Choose technology and test type

e Create the mobile test

Run a mobile test and get the report
The following chapters explain each of these steps in detail.

Prepare your device

Before you can connect your device to Ranorex Studio and add it as an endpoint, you need to
make certain preparations.

Android device settings
Activate developer mode

Mobile testing requires that some developer mode settings be activated. This mode is
normally hidden on Android devices. To activate it:

Go to your device’s settings.

Find the Build number entry. It’s normally located in the About section, but the
exact location may vary depending on device manufacturer and Android version.
Refer to your device’s documentation for more information.

Tap the Build number quickly seven times.

o0 ©0

The notification You are now a developer indicates that developer mode is now
active.



The settings should now contain an entry called Developer options:
L]

[ 2N I

~ System [7]

Languages & input
@ Gboard

Backup
[+ TR
{} Developer options

System update
Updated to Android 8.0.0

Activate Stay awake
*+m o & B 10:09
<  Developer options 12
On ®
E Memary

Take bug report

Deskiop backup password

Desktop full backups aren't currently pratected

Stay awake .

Screen will never sleep while charging

Enable Bluetooth HCI snoop log .
Capture all bluetooth HCI packets in a fike

Enable USB debugging

o In the Developer options, enable USB debugging.

9 Confirm.



.. S % 2 B 1027
&  Developer options (7] .
g Allow USB debugging?
On @

USB debugging is intended for
S development purposes only. Use it to copy
data between your computer and your
device, install apps on your device without
System Ul demo mode notification, and read log data.

Automatic system updates

Quick settings developer tiles CANCEL 0K 9

Debugging

USB debugging

Debug mode when USB is connected

(- - |

® ©

A\ Attention

For some Android devices, USB debugging does not work with the default
Windows USB driver. This makes testing with Ranorex Studio impossible. In
these cases, you need to install the device manufacturer’s special developer
USB drivers.

You can normally see that this is the case if Windows recognizes your device
correctly, but you can’t add it as an endpoint in Ranorex Studio.

Connect your device to a power source

Regardless of the connection type (USB/WiFi), make sure that your device is connected to a
power source at all times during test creation and execution.

This ensures that everything runs as intended and is particularly important for WiFi
connections, as it deactivates power saving.

iOS device settings

Deactivate Auto-Lock
o Go to your device’s settings.



e Select Display & Brightness.
e Set Auto-Lock to Never.

iPad F 0742 F 100 % -
Display & Brightness

Settings .
:+'.
Night Shift
Airplane Mode Auta-Lock Never
B wF A1-11d T
Bluetooth r Text Size
Bold Text
Notifications
5 control centre
Do Mat Disturb
@ Genaral
~4  Display & Brightness
) walpaper

Connect your devicetoa power source

Regardless of the connection type (USB/WiFi), make sure that your device is connected to a
power source at all times during test creation and execution.

This ensures that everything runs as intended and is particularly important for WiFi
connections, as it deactivates power saving.

Install the Ranorex Service App

To create and run mobile tests on your mobile device, you need to install the Ranorex Service
App on your device.

You can install it on your device by running the Instrumentation Wizard or by downloading
the app.

Update Service Instrumentation Wizard

After you have added your Android device as an Endpoint, run the Instrumentation Wizard.



Select Instrument a mobile device and click Next.

% Ranorex Instrumentation Wizard >

Instrumentation Wizard

Instrument a browser Instrument a mobile device

Choose between iOS and Android then click Next



3 Ranorex Instrumentation Wizard >

Instrument a mobile device

Choose your platform

Android

3. Under the Instrument a mobile device screen, select a device from the drop-down list,
and click Next.



% Ranorex Instrumentation Wizard x

Instrument a mobile device

Choose the device you want to instrument

Choose from existing .
devices LI

Add a new device

Use the Endpoints pad to add new Endpoints...
devices.

4. When the Ranorex Service is not installed on your device, the Instrumentation Wizard

opens the Update Service tab. Select the Update checkboxes for Ranorex Service
and Ranorex Web Testing and click Finish.



% Ranorex Instrumentation Wizard

Instrumentation Wizard

Choose your testing scenario and follow the steps below

Update service

o Ranorex Service
« Update

Uninstall

o Ranorex Web Testing
+| Update

Uninstall

5. Once the Operation successful message displays, click Finish.

Finish




% Ranorex Instrumentation Wizard

Operation successful

Your application has been successfully deployed to your device.
Please select "Install” on your device to finish the instrumentation process.

Finish

Download Ranorex Service App

Scan the QR code below or go to https://www.ranorex.com/rxApp to download the Ranorex
Service App.

Mobile download archive

The mobile download archive is categorized according to Ranorex Studio versions and
mobile OS. Simply download the correct Ranorex Service App.


https://www.ranorex.com/rxApp

Mobile Download Archive

This page provides download links for the latest Ranorex automation libs and service apps.

Note: A debug build with a debug profile is required to start and stop 105 apps via USB. The directly-installable IPA packages below have a distribution
profile, and do not support starting and stopping apps via USB. 105 distributables valid until November 11, 2021.

v Ranorex 9.5.1 - 10.0.0
Android (RxLibVersion 2.3.3)

[# Service App: Service App 2.3.3 | n
® Android Web Testing: RxBrowser 2.3.3

i0s

Directly Installable on Device

® Service App: RxServiceApp Distributable 3.2.4 |
® {0S Web Testing: RxBrowser Distributable 3.2.4
® Sample App: RxMiniKeePass Distributable 3.2.4

Manual Deployment

® RyAutomation Library: libRxAutomationUni 3.2.4

Ranorex Service App for Android

Ranorex Service App foriOS

Install the Ranorex Service App on Android
Tap the download link.

9 Confirm the security dialog.

Android (RxLibVersion 2.3.3)

® Service App| Service App 2.3.3
e Android Web Testing: RxBrowser 2.3.3

9 Tap Settings in the following dialog.
e Enable Allow from this source.



[ [ i 9 & W 8:50

Install unknown apps 2]
€ Chrome
For your security, your phone is not allowed
to install unknown apps from this source. ‘ Chrome (i ]
66.0.3359.126

CANCEL - € 1

| Allow from this source 0 [ ) |

Your phone and personal data are more vulnerable
to attack by unknown apps. By installing apps from
this source, you agree that you are responsible for
any damage to your phone or loss of data that may
result from their use.

e Confirm the access dialog.
9 The Ranorex Service App has been installed successfully.

I3 0w & mas
A Ranorex Services

Do you want to install this application? It
will get access to:

madify system settings

read your contacts

access approximate location (network-based)
access precise location (GPS and D Nexus 5)(

<o 0 2

network-based) Model: Nexus 5%
Service Yersion: 2.0.1

.

read call log

read your text messages (SMS or MMS)
M modify or delete the contents of your

USE storage
read the contents of your USB storage

CANCEL | INSTALL e
O

Your Android device is now ready to be - connected to Ranorex Studio.

Install the Ranorex Service App on iOS
o Tap the download link.

9 Confirm the security dialog.


file:///C:/Users/Alejandra%20Barrientos/Desktop/Ale%20Barrientos/Ranorex/4.%20Web%20and%20Mobile%20Testing/3.%20mobile-testing-2/connect-mobile-devices/index.html

i0S
Directly Installable on Device

“‘www.ranorex.com” would

. SeNicevApﬂRxServiceAgp Distributable 3.2.4 | like to Install *RxSarvicaApp
® Sample App: RxMiniKeePass Distributable 3.2.4

e The Ranorex Service App appears on the home screen.

iOS considers the Ranorex Service App “untrusted” because it wasn’t downloaded
from the App Store. Close the dialog.

Untrusted Enterprise
Developer
*iPhone Distribution: Ranorex GmbH"

has not been trusted on this iPad. Until
this developer has been d, their

enterprise apps will not be available for
use.

Cancel 6



Confirm Ranorex Service App as trusted
Before you can use the Service App, it needs to be trusted.

o Go to Settings > General.
9 Go to Device Management.

IPad ¥ 56 EXTET |

§ General Device Management

Settings

@ Ranorax GmbH 9

&

Airplane fMode — =
a Wi-Fi f AFFS5 FAOM DEVELDFER “IFHONE DISTRAEUTION: RANOREX GMBH Trust "iPhone Distribation;
- . Ranorax GmbH" Apgs on This
- ReSarvicadpp Pad
Blustooth

Trustire will alkcw any app from this
anarpriie davalopar bo b ussd on
o i2d and mey alow sccees (o vour
data.

o conce @) ]
b >
¥

B rectitications

a Controd Centre

Do Mot Disturk

I

m Display & Brightness

- RxSarvicadpp 6

Tap Ranorex GmbH.
Tap Trust “Ranorex GmbH”.

Tap Trust.

0000

The Ranorex Service App is now trusted.

Your iOS device is now ready to be connected to Ranorex Studio.

Connect mobile devices

Before you can create and run tests on your mobile device, you need to connect it to your
computer and to Ranorex Studio. This requires adding your device as an endpoint in Ranorex
Studio.


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/connect-mobile-devices/

Connection types

You can connect your device to the computer that Ranorex Studio is installed on via USB or
WiFi. The following tables illustrate the differences between these connection types for
Android and iOS. We recommend using a USB connection, as this has no restrictions in
terms of functionality and is generally more reliable.

© Note

Ports 31000 TCP and 31000 UDP must be open on your computer.

Android i0S

uUSB Wi-Fi uSB Wi-Fi
Create tests @ @ @ @
Run tests @ @ @ @
Start/stop app @ @ @ @
Install APK @) ©
Install IPA @) )
Deploy (unattended) @ ® @ ®
Automate system apps @ ®

Connection requirements

Android USB connection

For some Android devices, USB debugging does not work with the default Windows USB
driver. This makes testing with Ranorex Studio impossible. In these cases, you need to install

the device manufacturer’s special developer USB drivers.

You can normally see that this is the case if Windows recognizes your devices correctly, but
you can’t add it as an endpoint in Ranorex Studio.

iOS USB connection

You must install iTunes to connect your iOS device to your computer via USB. It provides the
required drivers.



General network requirements and recommendations
Connect device to a power source

Regardless of the connection type (USB/WiFi), make sure that your device is connected to a
power source at all times during test creation and execution.

WiFi network
When connecting via WiFi, the mobile device must be in the same network as the computer.
USB hubs

When connecting via USB, avoid USB hubs. Always use your computers integrated USB ports
if possible.

Connect a device and add it as an endpoint

@ Note

In this example, the device is connected via USB. The process is basically the
same when connected via WiFi.

Connect the device to your computer via USB

For Android devices, a short sound will normally indicate that the device has been
recognized.

For iOS devices, iTunes will automatically open if the device is recognized.
The device also appears in your Windows settings if connected properly.

Add the device as an endpoint in Ranorex Studio
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Adding a mobile device as an endpoint is explained in

Web and mobile testing > Endpoints > > Add an Android/iOS endpoint

Instrument apps

Before you can use test automation with a mobile app, you must instrument the app.
Instrumenting an app means configuring the app so that Ranorex Studio can access the GUI
and functions of the app for the purpose of creating and running an automated test.

Instrumenting apps works differently for Android and iOS, which is why the procedures are
explained separately in this chapter.

A Attention

Whenever you update Ranorex Studio (i.e. use newer automation
libraries/Ranorex Service App), reinstrument your apps. Otherwise,
automation may not work as intended.

A\ Attention
For iOS developers: As part of the instrumentation process, the app will be
compiled with the Ranorex automation library. This library adds additional
functions and permissions to your IPA.

Do NOT publish instrumented apps to the App Store.

Instrumented apps do not work with TestFlight.

Preinstrumented Ranorex Web Browser for Android


https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/add-android-ios-endpoint/

For web tests on Android devices, the preinstrumented Ranorex web browser for Android is
required.

Download and install the Ranorex Web Browser

Scan the QR code below or go to https://www.ranorex.com/rxApp to download the
Ranorex Web Browser for Android.

9 Select the preinstrumented browser in the mobile download archive:

Mobile Download Archive

page provides download links for the latest Ranorex automation libs and service apps. Note: A debug build with

a debug profile is required to start and

=0 [0 slar and

SB. The directly-installable IPA packages below have a distribution profile, and do not support startir g and stopping apps via USB

A Ranorex 8.2.0
Android (RxLibVersion 2.0.1)

® Service App: Se ai(.-_-'.|_|._; 0.1

| ¢ Android Web Testing: RxBrowser 2.0.1

e Install it as you would any other app on your mobile device.


https://www.ranorex.com/rxApp

EmY <00FE

_1" Ranorex Services

BACK FORWARD  REFRESH G0
Nexus 5X

Modal: Nexus 5X
Service Version: 2.0.1

/% Ranorex Web Testing
@y AutomationLib: 2.0.1

Opened Ranorex Web Browser.
The app is also listed in the Ranorex Service App, which indicates that it has been
instrumented correctly.

Preinstrumented Ranorex Web Browser for i0OS

For web tests on iOS devices, the preinstrumented Ranorex web browser for iOS is required.

Download and install the Ranorex web browser
Scan the QR code below or go to https://www.ranorex.com/rxApp to download the

Ranorex Web Browser for iOS.

e Select the preinstrumented browser in the mobile download archive:


https://www.ranorex.com/rxApp

Mobile Download Archive

W Ranorex 8.2.0
Android (RxLibVersion 2.0.1)

Apip: Service App 2.0.1

Veb Tasting: RxBrowser 2.0,

i0s
Directly Installable on Devies
jiceApp Distributable 3.0,0 tvalid ynii| Sep. 7, 2018

g: RxBrowser Distributable 3.0.2 (valid until Sep. 7, 2018

® Sample ApDT KxMIniRe tlu"-wl.-l nbulabie 3.0.2 (valld unlil Sap. 18

e Install it as you would any other app on your mobile device.

- Ranorex Services - Apps
RxBrowser
'
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Opened Ranorex Web Browser.

w2 Theappisalso listed in the Ranorex Service App, which indicates that it has been
instrumented correctly.

Instrument an Android app

You need to instrument Android apps before you can use them for mobile tests with Ranorex
Studio.



@ Note

It’s not possible to instrument apps that have been downloaded from Google
Play.
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Instrumenting Android apps is explained in the following chapter:

Interfaces and connectivity > Ranorex Instrumentation Wizard > > Android apps.

Instrument an iOS app

You need to instrument iOS apps before you can use them for mobile tests with Ranorex
Studio.

A Attention

Instrumenting iOS apps is challenging and not self-explanatory. It’s best done
by experienced iOS developers. To allow you to evaluate iOS testing with
Ranorex Studio without the hassle of instrumenting your own app, we provide
the preinstrumented KeePass app for your use.



https://www.ranorex.com/help/latest/interfaces-connectivity/instrumentation-wizard/android/

A\ Attention

For iOS developers: As part of the instrumentation process, the app will be compiled
with the Ranorex automation library. This library adds additional functions and
permissions to your IPA.

Do NOT publish instrumented apps to the App Store.

Instrumented apps do not work with TestFlight.

@ Note

It’s not possible to instrument apps that have been downloaded from the App Store,
as they are subject to DRM restrictions.

Instrumenting an iOS app means integrating a special Ranorex library (Ranorex libs) into the
source code of the app and then compiling it. Afterwards, the app needs to be signed with a
P12 certificate and the proper provisioning profile.

For more information on iOS development and release procedures, please refer to the official
Apple documentation.

There are two ways to instrument iOS apps:

e With the Ranorex Instrumentation Wizard (recommended)

=)
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Instrumenting iOS apps using the Instrumentation Wizard is explained in:

Interfaces and connectivity > Ranorex Instrumentation Wizard > - i0S apps

e Manual instrumentation of the source code in iOS with Xcode
iOS developers can integrate the Ranorex library, compile it, and sign the app
manually using Xcode.


https://www.ranorex.com/help/latest/interfaces-connectivity/instrumentation-wizard/ios/
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Manual instrumentation is explained in the following chapter:

Web and mobile testing > Advanced mobile testing > - i0S source-code
instrumentation

A\ Attention

After instrumenting and deploying the iOS app for the first time, start the app
manually once! Otherwise, it will not be visible within the Ranorex Service App.

Preinstrumented iOS sample app

Ranorex provides a preinstrumented iOS sample app for evaluation and learning purposes.
The app is KeyPass for iOS, distributed under the GNU General Publice License. For
information regarding the copyright holder and the license agreement, go to
https://keepass.info/help/v1/license.html.

Download and install the sample app
o Scan the QR code below or go to https://www.ranorex.com/rxApp.

and mobile OS. Download the RxMiniKeePass app for iOS devices for your Ranorex
Studio version.

9 The mobile download archive is categorized according to Ranorex Studio versions
9 Next, install the sample app as you would any other app on your device.


https://www.ranorex.com/help/latest/web-mobile-testing/advanced-mobile-testing/instrumentation-source-code-ios/
https://www.ranorex.com/help/latest/web-mobile-testing/advanced-mobile-testing/instrumentation-source-code-ios/
https://keepass.info/help/v1/license.html
https://www.ranorex.com/rxApp

" Ranorex Services - Apps
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SMniKeePass
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The RxMiniKeypass app appears on your home screen.
Since the app is already instrumented, it also automatically appears in the Ranorex
Service App.

Create a mobile test

In this chapter, you’ll learn about the basics of creating a mobile test in Ranorex Studio.
Prerequisites
Before creating a mobile test, make sure you’ve completed all the necessary preparations:

o Apply the necessary - device settings to your device and install the Ranorex
Service App.
-» Connect your device to the computer and -» add it as an endpoint in Ranorex
Studio.

e Finally:

o If you want to test a mobile app, - instrument the app.

o If you want to carry out a web test on your device, - install the
preinstrumented Ranorex Web Browser for Android (recommended) and/or
i0S (required).

Create a solution for mobile testing

To create a mobile test, you must use the RocketStart Wizard.


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/prepare-your-device/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/connect-mobile-devices/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/add-android-ios-endpoint/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/

On the Ranorex Studio start page, click New solution using wizard... or click File >
New > New solution using wizard...

9 Click Mobile.

R Rancrex Sude - o s

¥ Rx Ranorex Studio &

X Wekome to Renorex Studio

Welcome to Ranorex Studio 8
How do you want to start?

Start

B3 New test solution..

B New test solution using wizard...

Recent projects Welcome to

Ranorex Studio 8

e Follow the instructions of the wizard.

9 When you get to the screen below, choose which kind of mobile test you want to
create and click Continue.
Mobile iOS app test

Mobile Android app test
Mobile iOS web test
Mobile Android web test



3% Create your new solution

%

Set up mobile testing

‘Which mobile applicabon do you want to test?

Android app Web test on 05

Wb test on Android

d

« Bs 4 Continue »

e Depending on your choice, the wizard will show you a checklist of necessary
preparations. If you followed our instructions under Prerequisites, you should
already have completed all of them. Click Continue.

6 Click Finish.

Continue »

The prebuilt web test will look like this:

Finish




""" MobileTest.ndst X

T Recordingl.mrec % 3 AN
RECORD
ltem - © Add new action ~ O
i MobileTest -t s =~ = Action
T - ([ | TestCase
E RecordingT_
Test suite view

This is where you build and control your tests.
The test suite contains a test case with the empty recording module Recordingl.

© Note

The recording module has a different symbol than usual. This indicates that it’s
a mobile recording module, suitable only for building mobile tests. Standard
recording functionality is disabled for them.

All recording modules you create in this project are mobile recording modules.

Recording module view
In the recording module view of Recordingl, you can start creating your mobile test

by adding actions.
.81 Empty actions table
This is where your actions appear.

Create a mobile test

Now that we have our solution, we can start creating the actual mobile test. The procedure is
different from that for creating desktop or web tests, but it’s not complicated.



o Click RECORD.
e The dialog for selecting the mobile device and instrumented app appears.
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RECORD
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o [

Web Drephox

] Restart 2pp [ ] © Addapp..
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Select your device and app. If you select the Ranorex Web Browser, also specify the
URL for the mobile web test.

Recording

Create a mobile test

Create a mobile test

Chocse s device: Create 3 mohile test

Chocse 3 device:

Create a mohbile test

Choose & device:

ﬂ Chopze a device:
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USE-00c1Becf ... R iPad -

USB-00c 1 Bocf ... RX iFad

Choose ar add app: L * —

D{’ Chocse or add app: 1 Chone o oo |
Chocse or add app:
= o TE G

B R 0 Wek Dropbax E\ E\
e 2R [ Restart app o Wek Il KeaP gss 9 ﬁ

: A Restet zpp @ Wk MinikiseR ass.
Cheese websibe [ Restartspp @
|I|"|'\'|’-'#Mfex'(¢l'ﬂ &
Eack AN e O Choose webibe
e G e (O
M | W B R COm
Eack

(2] (b] o (d)
Depending on your choice, different test types result. In our example:

o Mobile Android web tests using the preinstrumented Ranorex Web Browser



o Mobile Android app test using the instrumented Dropbox app
° Mobile iOS web tests using the preinstrumented Ranorex Web Browser
o Mobile iOS app test using the instrumented MiniKeePass app

@ Note

If your app doesn’t appear for selection, make sure that you’ve instrumented it
correctly.

Setup mobile test building

o Click Create to start the setup process for mobile test creation.

jo Buibl Dtbug Smwech Tock Wedee Hel
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RECORD Recording]

Create 3 mobile test

Chooze a device:

4

USB-00c Bocf ... RX iPad

Choose or add appe
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Wb

[ Restart 2pp @ D Addapp...
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Ranorex Studio will automatically carry out the following processes to set up mobile test
building:

In Ranorex Studio

Ranorex Studio starts the selected app on your mobile device and adds the respective action
in the action table.



Detautt lageaz ~ D

¥ Endposms

-
e vamiasis. | B SiTTINGE. e Sdo

Add nuw action *

Action
Run mobile app  Current Endpoint (USB-00c12ccf52663703) com.drepbox.android True

F

The RUN button changes to reflect that it now runs the test on the current
automation root, i.e. the active endpoint/mobile devices, not the computer.

An action that starts the app on the mobile device has been added to the action
table.

On the mobile device

The instrumented device starts on the mobile device. In our case, this is the Dropbox mobile
app.

Empty folder




A Attention

Regarding mobile iOS applications, it is necessary that the Ranorex Service
Application is running and active on the mobile device. Ensure that it is not
running in the background as this may prevent you from using the start/stop

functionality for the mobile application.

Ranorex Spy

Ranorex Spy starts in live tracking mode for all Ul elements of the instrumented mobile app.

3 Ranorex Spy - (32bit) - Live

E SETTINGS..

ELEMENT
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Tracking OFF: Press Cirl+-LWin for instant trackong.

Element browser in Spy showing all the Ul elements of the instrumented app.

Live view of the instrumented app on the mobile device

Build the test

Building a mobile test consists of two consecutive, iterated steps:



Tap-Track-Add J{

]

l >a Drag-Drop-Define

Step 1: Tap, Track, and Add

In this step, you add a Ul element as a repository item to Ranorex Studio to make it available

for use in actions.

Tap: Make the element visible in the app, e.g. by tapping it.
Track: Update the live tracking in Spy by clicking Browse endpoint or Refresh.
Add: Select the element in the element tree, right-click it, and add it to the

repository. Alternatively, drag and drop it in the repository.
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Step 2: Drag, Drop, and Define

In the second step, you “process” the Ul element, i.e. you use it in an action.

@
(2]

action table.

the desired action.

Drag: From the repository, drag the repository item to the desired position in the

Drop: Drop it by releasing the left mouse button. The context menu opens. Select



Define: Make any necessary configurations to the action, e.g. setting timeouts,
content of key sequences, etc. The finished action is shown in the action table,
linked to the repository item representing the respective Ul element in the app.
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Set value 3

Close application
Wait for

i @[ 4

-l

Capture screenshot
Create snapshot

User code 3

© Note

You can shorten the procedure by directly dragging a Ul element from Spy to the
action table.

Ell Reference

You can find step-by-step instructions for creating mobile tests in

Web and mobile testing -> Mobile testing > -» Android app testing example / - Android
mobile web test example

Web and mobile testing -> Mobile testing > - i0S app testing example / > i0S mobile
web test example


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/android-app-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/android-mobile-web-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/android-mobile-web-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/ios-app-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/ios-mobile-web-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/ios-mobile-web-test-example/

Tips for efficient test building

Remote control your app from Spy

You can remote control your app through Spy. This way, you won’t have to carry out all the
actions to bring up menus and different screens in the app on the actual mobile device.

o In the live view of Spy, right-click a Ul element and click Touch/Tap.

9 The action is executed on your mobile device as if you actually touched the screen.
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Enter text in Spy instead

You can also enter text in a similar way.

H AndroidElemaent

o MabileApp ‘cam.dropbos andiaid’
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§ www
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‘android.widget ActionMenuView'

¥ & * A

Draphon
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B Zoom to fit
£ Zoom 100%

e  Saveimage as...

[+] Show gecmetry

o In Spy, with a Ul element selected, click the Advanced tab.

e Find the Text attribute, enter your text, and confirm with Enter.

[+] Live tracking

e The text appears in the mobile app as if you typed it in using the screen keyboard.
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Run a mobile test

For the most part, running mobile tests works the same as for any other test. There are just a
few preparations required.

Preparation
To execute a test on a mobile device, you need to make the following preparations:

e The device must be set as automation root in the endpoints pad. Alternatively, you
can specify an endpoint in the Run mobile app action. It will then override the
automation root.

e The Ranorex Service App must be installed on the mobile device.

Run the test
With the above preparations made, you can run the test like any other.

In the test suite view, click RUN. The test will be started and run on the mobile
device.
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A\ Attention

Do not touch the screen or any buttons on the mobile device while the test is
running. This would result in a test failure.

ﬁ Note

The various available options for test runs are also the same as for other
tests. For more information, refer to -» Execute a test suite.

Report

Once the test run has finished, the report appears.



https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/test-suite/running-tests/
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The report for mobile tests does not differ from that for other tests.

-
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Reports are explained in Ranorex Studio fundamentals > Reports > - Introduction

Android app testing example

In this chapter, we’ll go through an Android app test step by step.
Test scenario
We'll test the freely available Dropbox mobile app. Our test contains the following steps:

Start the Dropbox app on the Android device.

Check if the Dropbox is empty.

Create a new folder called MyDocuments.

Create a screenshot of the Dropbox desktop with the folder in it.
Delete the folder.

Check if the Dropbox is empty.

ok wN


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/reporting/introduction/

7. Close the app.
Preparations

Device settings

e Apply the required - device settings to your Android device and install the Ranorex
Service App.

Connect mobile device

e > Connect your mobile device to your computer, preferably via USB, and - add it as
an endpoint in Ranorex Studio.

Instrument the app

e Download the Dropbox APK from the Dropbox website and - instrument it.
Create a Dropbox account

e You’ll need a free Dropbox account. Create one at www.dropbox.com.
Create a solution for mobile testing

o ~> Create a new solution for mobile testing using the RocketStart wizard.

9 Open the Endpoints pad.
9 Open the recording module Recordingl.rxrec.

Ranorex Studio should now look as follows:
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https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/prepare-your-device/
file:///C:/Users/Alejandra%20Barrientos/Desktop/Ale%20Barrientos/Ranorex/4.%20Web%20and%20Mobile%20Testing/3.%20mobile-testing-2/connect-mobile-devices/index.html
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/add-android-ios-endpoint/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/add-android-ios-endpoint/
https://www.ranorex.com/help/latest/interfaces-connectivity/instrumentation-wizard/android/
http://www.dropbox.com/
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Empty action table in the recording module
Empty repository

Your device in the Endpoints pad.

QENE

Ranorex Service App running on the mobile device, showing the Dropbox app as
instrumented.

Create the test

o Click RECORD.

9 The dialog for selecting the mobile device and instrumented app appears.
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Choese a device:
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| USB-00c1Becf | Rt iPad

Choese or add app:

o Lo \

Web

[ Restert 2pp O Adurs..
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9 Select your Android device and app (the Dropbox app) and click Create.



Recording b4

Create a mobile test

Chooze a device:

Choose or add app:

(& | Lo

Web Dropbex
B Restert spp @ @ Add dpp...
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Setup
Ranorex Studio now executes the following processes to set up mobile test building.

In Ranorex Studio

Ranorex Studio starts the selected app on your mobile device and adds the respective action
in the action table.

Detaat lagsas ~

e vamiasis | B SITTINGS.

) Add new action + % Turko mode ([ Screerahot

Y T —— Action

o 7
-_ E 1 Run mobile app  Current Endpoint (USB-00c12ccf52663703) com.drepbox.android True

The RUN button changes to reflect that it now runs the test on the current
automation root, i.e. the active endpoint/mobile devices, not the computer.

An action that starts the app on the mobile device has been added to the action
table.



On the mobile device

The instrumented app starts on the mobile device. In our case, this is the Dropbox mobile
app.

Empty folder

Ranorex Spy

Ranorex Spy starts in live tracking mode for all Ul elements of the instrumented mobile app.

3 Ranores Spy - (32bit) - Live
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Tracking OFF: Press Ctrl+LWin for instant trackng.



Element browser in Spy showing all the Ul elements of the instrumented app.

Live view of the instrumented app on the mobile device.

Build the recording module

Now we can start filling our recording module with actions.

We’ll do this using the two-step test-building procedure for mobile tests as explained in detail

in > Create a mobile test.
Validate that the Dropbox is empty

Step 1: Identify validation text

Click Refresh in Spy.

Empty folder

D0 Welisipies

Ensure that the validation text Empty folder is visible on the mobile device.

Drag the Ul element for Empty folder from Spy to the repository in Ranorex Studio.

ftem

" 4 —

=-[_] Container Frame'
§’| Text 'Empty folder'

Trcieng GFF: Prame Ciste L farinstant Sieciong.

Step 2: Define validation

@ Add new itemn ~ Track..

- [ ComDropboxandrois

AL

Path
Base: /mobileapp|@title="com.d
Torm[@tle= DrophasaionBar

= | EF] AndroidAp

2] EmptyFolder

L
7‘ O

pty folder

o Drag the new repository item to last position in the action table.

9 In the context menu that opens, click Validation.


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/create-a-mobile-test/

Define the Validation action: For Match-Name, select Text and for Match-Value,
enter “Empty folder”.

o LR
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Open the menu
Step 1: Identify Ul element

o Ensure that the button for opening the menu is visible on the mobile device.

9 Click Refresh in Spy.
e Drag the Ul element for the button from Spy to the repository in Ranorex Studio.

Upicad here

m cropior ancroed Jerm| Etithe = Tropboshctio
Waw flder )

Mt M1k fowser & REsULTS

Track... 1 9

Add new item ~
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Sort
= Path
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Tracking GFF: Prews Cit+ L farirntart Siacking.

Step 2: Define action



Drag the new repository item to last position in the action table.

Define the Validation action: For Match-Name, select Text and for Match-Value,
enter “Empty folder”.

9 In the context menu that opens, click Validation.

Endpoints

Swipe gesture

Mohile key press

Validation

JO0 e - - T = e
] €2 Add new action - | 3¢ ||j| Fl & |9 Zk Turbo mode |i. Screensh0t|
0 Get
e ¥
= e =0 # Action Touch type Action spot Repository item
MareOpti "'t
= a g1 Run mobile app Current Endpeint... com.dropb... True
o
® wai [E2 Validate + AttributeEqual Text Empty folder =] EmptyFolder
3 Touch QTouch ~ |Center V| o MoreQptions

© Note

Creating these first two actions illustrates the 2-step procedure, which remains
the same for the following actions. Therefore, the following instructions don’t
describe the procedure in quite as much detail.

Create a new folder

The option to create a new folder is located in the breadcrumb menu of the Dropbox app.

o Add the Ul element for the menu option New folder to your repository with Spy.
9 Create a Touch action with this repository item.
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Touch action linked to the repository item for the menu option New folder.

Enter folder name and create folder

Add the Ul elements for the Folder name text field and the Create button to your
repository with Spy.
9 Create the following three actions with these repository items:

Rocprdingiose X Srew
recear R RRuM e VA RIKELE

5 Touch Touch Relative =] AndroidWidgetEditText
] Set value Text MyDocum... =] AndroidWidgetEditText
7 Touch Touch Relative Button1
; ~ Teisr L : —
Rk raw foarr. v = o [ Androititgs beifleponiory = | v Yarabl .
[ ComDrpbasirdrid I.w. e gl e o A B B BT
E] AndroidWidgetEditText form[@title="Create new folder']/container[@rid="con
Buttani form[@title="Create new folder]/container[@rid="con




Touch action to place the cursor in the text field.
Set value action to enter the folder name.

Touch action tapping Create to create the folder.

BNE

Hint

If you want to test the functionality of the on-screen keyboard, you can also

automate entering the name by a series of touch actions on the keys.
Validate folder

Now we’ll validate that the folder exists. We’ll use image-based validation for this purpose.

o Add the folder image to your repository with Spy.
9 Create the following action with this repository item.

ch  Toskh Wircow  Hap
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Validation action that uses image-based validation.




% Reference

Image-based validation is explained in Ranorex Studio fundamentals > Validation > -
Image-based validation

Delete folder

Deleting the folder requires that we open a menu, tap the first Delete button, and then tap
the second Delete button.

o Add the three required Ul elements to your repository with Spy.
9 Create the following actions with this repository item.

ch Tash ‘Wircow Hp

ohRL B E

Recoringiuoes % arovssbonlet o Fen
Recenn R R RuM

:
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i
4
©o  Touch Touch Relative [%] AndroidWidgetCheckBox
.‘ﬁ:iﬁﬂ:t‘é” it e Q_'I{}I Touch Touch Relative Delete
i El %_ 11 Touch Touch Relative Buttoni1
i
0 | = SE e
AndroidWidgetCheckBox form[@title="DropboxAdionBarAdivity'l/container[@
* Delete 7/T/container[@containertype="Linear]/button[@text
Buttoni1 form[@title="MyDocuments’]/container[@rid="conten

Opens the folder menu by tapping the respective symbol.
Taps the first Delete button.
Taps the second Delete button.

Validate that the folder has been deleted and close app

o The repository items that we need already exist. Use them to create the following
two actions.
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Enngly fokdir
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. Validates that the Dropbox home screen is empty (a simple copy of action #2).

. Closes the app.

Completed recording module

If you followed our instructions, your completed recording should look like this:

= VARIABLES.. || B SETTINGS..

. @ Add new action = 3¢ M & | ® @ | a4 w |k Turbomode |[ig Screenshot
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You can now switch to the test suite view and run the test. However, in a real-life scenario, the
test wouldn’t be quite finished here. The next step would be to modularize the recording and
structure the test suite.



The concepts of modularizing and structuring apply to all recording modules and test suites,
whether for desktop, web, or mobile tests.

-
%"J Reference

Managing recording modules is explained in:

Ranorex Studio fundamentals > Ranorex Studio Overview > -» Manage recording
modules

Structuring a test suite is explained in:
Ranorex Studio fundamentals > Ranorex Studio Overview > - Test suite structure

A step-by-step example of building a full test suite is available in:
Ranorex Studio fundamentals > Ranorex Studio Overview > - Build a test

Android mobile web test example

In this chapter, we’ll cover the initial steps of a mobile web test on an Android device. After
these initial steps, test creation follows the same principles as in the > Android app test
example and -» general web test creation.

Preparations

To create a mobile web test, you need to make the following preparations:

Device settings

e Apply the required - device settings to your Android device and install the Ranorex
Service App.

Connect mobile device

e > Connect your mobile device to your computer, preferably via USB, and - add it as
an endpoint in Ranorex Studio.

Install the Ranorex Web Browser app for Android
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e Ranorex provides a - preinstrumented web browser that is required for creating and
executing Android web tests.

Choose a mobile browser

Ranorex provides a preinstrumented web browser. You need to use this browser to automate
Android web tests.

%1] Reference

Installing this app is explained in Web and mobile testing > Mobile testing > -
Instrument apps

Create a solution for mobile testing

o -> Create a new solution for mobile testing using the RocketStart wizard.

9 Open the Endpoints pad.
e Open the recording module Recordingl.rxrec.

Ranorex Studio should now look as follows:
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=
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tem Fakh

(l| Empty action table in the recording module

w» Empty repository

¢8| Yourdevicein the endpoints pad


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/create-a-mobile-test/

.8l Ranorex Service App running on the mobile device, showing the preinstrumented
web browser app. If you chose a different web browser and instrumented it
correctly, it will also appear here.

Create the test

o Click RECORD.
9 The dialog for selecting the mobile device and instrumented app appears.
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e Select your Android device app (web browser), specify the URL, and click Create.
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Setup
Ranorex Studio now executes the following processes to set up mobile test building:

In Ranorex Studio

Ranorex Studio starts the selected app on your mobile device and adds the respective actions
in the action table.

W AndroidWebTest - Ranorex Studic
1 Builkd Debug Sesrch Took Window
s B E B L - w
B X Recordnglwec” X l
E: .
RECORD " VARIABLES || B SETTINGS._ Fve Shuchio

W IO & |9 @ . w |k Turbo mode ||l Screenshot
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0 Add new item +

- L Patn
[ Browsss Baie: okl eappDiit= ranone: BxEiowier|

& AndroaddiebTast 4| Dom Eate: /mobdsappi@titer rarones Bcbirowner | dom

The RUN button changes to reflect that it now runs the test on the current
automation root, i.e. the active endpoint/mobile devices, not the computer.

An action that starts the app on the mobile device has been added to the action
table.

An action that navigates to the specified URL in the selected browser app has also
been added.

On the mobile device

Ranorex Studio starts the selected browser and navigates to the specified URL on the mobile
device.
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Ranorex Spy

Ranorex Spy starts in live tracking mode for all Ul elements of the instrumented mobile app.
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Element browser in Spy showing all the Ul elements of the instrumented app.



Live view of the instrumented app on the mobile device.

Build the test

From this point forward, test building follows the same principles as in the - Android app
test example and - general web test creation.

iOS app testing example

In this chapter, we’ll go through an iOS app test step by step.
Test scenario

We’ll test the preinstrumented iOS KeyPass mobile app that you can download from the
Ranorex website. Our test contains the following steps:

Start the app on the iOS device.
Create a new password database.
Name it MyPasswords.

Give it the password 1234.

Check if the category General exists.
Exit the app.

ok wpnRE

Preparations
Device settings

e Applytherequired - device settings to your iOS device and install the Ranorex
Service App.

Connect mobile device

e - Connect your mobile device to your computer, preferably via USB, and - add it as
an endpointin Ranorex Studio.

Instrument the app

e Download the - preinstrumented KeyPass app from our mobile download archive
and install it on your device.

Create a solution for mobile testing
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~> Create a new solution for mobile testing using the RocketStart wizard.
Open the Endpoints pad.

Open the recording module Recordingl.rxrec.

o000

Ranorex Studio should now look as follows:
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sl @9 Add new action =

1= Actron

(2= o I

@ Add new item = & Track... Iﬂ_
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Empty action table in the recording module
Empty repository

Your device in the Endpoints pad.

QENE

Ranorex Service App running on the mobile device, showing the KeyPass app as
instrumented.

Create the test

° Click RECORD.
9 The dialog for selecting the mobile device and instrumented app appears.
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Setup
Ranorex Studio now executes the following processes to set up mobile test building.

In Ranorex Studio

Ranorex Studio starts the selected app on your mobile device and adds the respective action
in the action table.
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The RUN button changes to reflect that it now runs the test on the current
automation root, i.e. the active endpoint/mobile devices, not the computer.

An action that starts the app on the mobile device has been added to the action
table.

On the mobile device

The instrumented app starts on the mobile device. In our case, this is the KeyPass mobile
app.

IPad ¥ M43 4 05 % -
Filag
Tap the + button to sdd a new KaePass file
e =
L \r LE
Ranorex Spy

Ranorex Spy starts in live tracking mode for all Ul elements of the instrumented mobile app.



3\ Ranores Spy - (32b#) - Live - a =

ELEMENT E SETTINGS...

BROWSER

[/mebileappl@tites ranorexMinikeePass]

BROWSER & RESULTS

‘ranorex.MiniKeePass
(& ﬁguﬁ] g i+ TeEx 04
= [J MobileDevice 'RX iPad’
= D MobileApp ranorex.MiniKeePass
=[] Form 'UlWindow'
] Container ‘LayoutCaontainer -—
] Container TextEffectsWindow'

‘ranorex.MiniKeePass’

0 Mobile]
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Element browser in Spy showing all the Ul elements of the instrumented 100app.
Live view of the instrumented app on the mobile device.

Build the recording module

Now we can start filling our recording module with actions.

We’ll do this using the two-step test-building procedure for mobile tests as explained in detail
in > Create a mobile test.

Create new password database
Step 1: Identify Ul element and add to repository

o Ensure that the + button is visible on the mobile device.
9 Click Refresh in Spy.
e Drag the Ul element for Empty folder from Spy to the repository in Ranorex Studio.
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Step 2: Define action

6 Drag the new repository item to last position in the action table.
6 In the context menu that opens, click Touch.

6 The Touch action needs no further definition and is complete.
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© Note

Creating this action illustrates the 2-step procedure. It remains the same for the
following actions. Therefore, the following instructions don’t describe the
procedure in quite as much detail.

Enter the database name

After tapping the + button, a dialog opens asking for a name and a password for the new
database. To enter the name, we’ll need to create two actions.

o Add the name text field to your repository with Spy.
9 Create the following two actions with this repository item:
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Touch action that places the cursor in the text field.
Set value action that enters the name.

Hint

If you want to test the functionality of the on-screen keyboard, you can also
implement entering the name by a series of touch actions on the keys.



Enter and confirm the database password
Add the two text fields for the password and its confirmation to your repository with
Spy.
9 Create the following four actions with these repository items:
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password.
Touch action and Set value action to place the cursor in the text field and repeat the
password.

Confirm database creation
o Add the Done button to your repository with Spy.

9 Create the following action with this repository item:
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Touch action that taps the Done button to confirm database creation.

Validate database file
Now we’ll validate whether the database was created correctly.

o Add the file name to your repository with Spy.
9 Create the following action with this repository item:
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Validates that the displayed file name is the same as the one entered during
database creation.

Delete database and close app
o Add the Edit, (-) and Delete buttons to to your repository with Spy.

9 Create the following actions with these repository items:
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Touch action that taps Delete to confirm deletion.

If you followed our instructions, your completed recording should look like this:
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You can now switch to the test suite view and run the test. However, in a real-life scenario, the
test wouldn’t be quite finished here. The next step would be to modularize the recording and

structure the test suite.



The concepts of modularizing and structuring apply to all recording modules and test suites
regardless of desktop, web, or mobile tests.

-
%"J Reference

Managing recording modules is explained in:
Ranorex Studio fundamentals > Ranorex Studio Overview > -» Manage recording
modules

Structuring a test suite is explained in:
Ranorex Studio fundamentals > Ranorex Studio Overview > - Test suite structure

A step-by-step example of building a full test suite is available in:
Ranorex Studio fundamentals > Ranorex Studio Overview > - Build a test

iOS mobile web test example

In this chapter, we’ll cover the initial steps of a mobile web test. After these initial steps, test
creation follows the same principles as in the - i0S app test example and - general web test
creation.

Preparations

To create a mobile web test, make the following preparations:

Device settings

e Apply the required - device settings to your iOS device and install the Ranorex
Service App.

Connect mobile device

e > Connect your mobile device to your computer, preferably via USB, and - add it as
an endpoint in Ranorex Studio.

Install the Ranorex Web Browser app for iOS


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/ranorex-recorder/managing-recording-modules/
https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/ranorex-recorder/managing-recording-modules/
https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/test-suite/test-suite-structure-elements/
https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/test-suite/build-a-test/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/ios-app-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/web-testing/build-a-web-test/
https://www.ranorex.com/help/latest/web-mobile-testing/web-testing/build-a-web-test/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/prepare-your-device/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/connect-mobile-devices/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/add-android-ios-endpoint/
https://www.ranorex.com/help/latest/web-mobile-testing/endpoints/add-android-ios-endpoint/

e Ranorex provides a - preinstrumented web browser that is required for creating and
executing iOS web tests.

Create a solution for mobile testing

° -> Create a new solution for mobile testing using the RocketStart wizard.

9 Open the Endpoints pad.
9 Open the recording module Recordingl.rxrec.

Ranorex Studio should now look as follows:
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Ranorex Service App running on the mobile device, showing the preinstrumented
web browser app.

QENE

Create the test

o Click RECORD.
9 The dialog for selecting the mobile device and instrumented app appears.


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/instrument-apps/
https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/create-a-mobile-test/
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Select your iOS device, select the app (Ranorex Web Browser), specify the URL, and
click Create.
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Setup
Ranorex Studio now executes the following processes to set up mobile test building:

In Ranorex Studio

Ranorex Studio starts the selected app on your mobile device and adds the respective actions
in the action table.
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The RUN button changes to reflect that it now runs the test on the current

automation root, i.e. the active endpoint/mobile devices, not the computer.

An action that starts the app on the mobile device has been added to the action
table.

An action that navigates to the specified URL in the web browser app has also been
added.

On the mobile device

Ranorex Studio starts the preinstrumented web browser and navigates to the specified URL
on the mobile device.
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Ranorex Spy

Ranorex Spy starts in live tracking mode for all Ul elements of the instrumented mobile app
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Element browser in Spy showing all the Ul elements of the instrumented app.
Live view of the instrumented app on the mobile device.

Build the test

From here on out, test building follows the same principles as in the - i0S app test example
and --» general web test creation.


https://www.ranorex.com/help/latest/web-mobile-testing/mobile-testing-2/ios-app-test-example/
https://www.ranorex.com/help/latest/web-mobile-testing/web-testing/build-a-web-test/

Advanced mobile testing

iOS Service App

This quick starting guide will show you, how to properly use the new iOS RxServiceApp to
create automated tests and how to prepare your iOS project so that start/stop app
functionality can be used.

Prepare Your iOS Project to Enable Start/Stop Functionality

The following step by step instructions are based on Xcode 6.

If the app will be instrumented manually, please do the following steps to register the custom
URL scheme so that the starting and stopping will work correctly:

e Openyour project in Xcode 6.x

e Follow the instructions in the section: Instrumentation with source code on i0S
e In Xcode choose the “Info” tab

e Under Custome iOS Target Properties add URL types key

e Expand URL types key with Item0

e Expand ItemO with URL schemes

e Expand URL schemes with Item0 and write the app activity name as value

Ceneral Capabilities Build Settings Build Phases Build Rules

| ¥ Custom iQ5 Target Properties

Bundle versions string, short e otring 1.0
¥ URL types + Array (1 itermn)
¥ ltem 0 Dictionary (1 item)
¥ URL Schemes L Array (1 itemn)
Itermn O O & String . ranorex.demoappﬁcaﬁon|
Bundle identifier L 5tring JZ6752UBVE. 5{PRODUCT_NAME:rfc 1034identifiel
InfoDictionary version + 5tring 6.0
b lcon files (i05 5) 4 Dictionary (1 item)
Bundle version %+ String 1.0
Main nib file base name (iPad) ¥ String MainWindow
Executable file %+ String ${EXECUTABLE_NAME}
Application reguires iPhone environment 3 Boolean YES .



https://www.ranorex.com/help/latest/web-mobile-testing/advanced-mobile-testing/instrumentation-source-code-ios-2/

o Note

e Ifno URL scheme is set, the app under test cannot be launched and you will get an
error message when you try to start the app with Ranorex. In the app list of the i0OS
RxServiceApp there will be also a warning message “Can’t launch”.

e After Instrumenting and deploying the app for the first time, start the app manually
once.

e The newly instrumented and deployed app, needs to be started manually for the
first time, so that it gets registered at the RxServiceApp.

e |Ifthe appisinstrumented with Ranorex Studio on the Windows machine, the
correct URL scheme will be set automatically.

e Duetorestrictionin Apple API it may occur that the instrumented IPA is not able to
run from with Ranorex Studio, while RxServices application is in the background
mode. It is recommended to perform any test while the instrumented IPAis in the
foreground

Proper use of the iOS Service App

To use the new start/stop functionality via USB or WiFi, make sure that the RxServiceApp is
running and is active on the device. You can either use the instrumentation wizard to deploy
the service app as described in - Instrumentation Wizard - iOS, or download and
install the service app on your device from our mobile download archive by scanning the
following QR Code or the using the following short URL:

Use the QR Code above or the url https://bitly.com/mArchive to directly access the
download archive on your mobile device.


https://www.ranorex.com/help/latest/interfaces-connectivity/instrumentation-wizard/ios/
https://www.ranorex.com/help/latest/ios-testing/ios-service-app

o Note

Start/Stop functionality can not be used from the home screen of the device, even if
the RxServiceApp is running in the background.

You can still create automated tests without the iOS RxServiceApp. Please note that without
the RxServiceApp the start/stop functionality won’t work.

To add a device without the service app, make sure that an instrumented app is running and
active on the device.

o Note

e When using the start functionality, the app under test will be launched multiple
times, because it needs to be reseted into initial state.

e If you want to create automated test on an instrumented app that has no URL
Scheme, please make sure, that the RxServiceApp is not installed on the device and
that the testing app is active on the device.

Non-Ul Testing

Next to automate testing of the user interface of mobile applications it’s also possible to
perform non-Ul tests invoking technology dependent actions (see -Detailed list of actions).
This feature allows you to get information about the devices hardware, the operating system
etc.

Non-Ul testing on Android

You are able to get the device info of your Android device directly by right-clicking the mobile
device in Ranorex Spy.


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/actions/detailed-list-actions/
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You can access the non-Ul testing methods in the action table by adding an invoke action on

the mobile app.




# Action
1 & Touch
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B Mobile Key Press
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You can also access the non-Ul testing methods within User Code Actions as well as Code
Modules.

The code should look something like the following:

C#

app = repo.AndroidApp.Self.As<AndroidApp>();

info = app.GetDevicelInfo();

sms = app.GetSms();

calls = app.GetCalls();

Report.Info("Manufacturer: + info.Manufacturer);

Report.Info("SMS: " + sms.ToString());




Report.Info("Calls: " + calls.ToString());

VB.NET

app = repo.AndroidApp.Self.[As](Of AndroidApp)()

info = app.GetDevicelInfo()

sms = app.GetSms()

calls = app.GetCalls()

Report.Info("Manufacturer: " & info.Manufacturer)

Report.Info("SMS: " & sms.ToString())

Report.Info("Calls: " & calls.ToString())

-
L_l| Reference

For further information about code modules and user code actions please have a look
at the chapters -»Code modules and -»User code actions.

Cross-device mobile tests

In this chapter, we’ll show you how you can configure one test to run on several different
devices of the same mobile OS (Android OR iOS) consecutively and even in parallel.

The configuration is based on data-driven testing and is the same for both Android and iOS.
For the sake of simplicity, the screenshots refer to Android only.


https://www.ranorex.com/help/latest/ranorex-studio-expert/code-modules/
https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/actions/user-code-actions/
https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/actions/user-code-actions/

© Note

Make sure to add a Close application action when running your test on different
devices. Otherwise, the tests may run in a different order or be skipped for some
devices.
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Configure a consecutive cross-device test

o Open the first recording module in your test. It should contain the Run mobile app
action.

9 Click the Endpoint property and click As new variable...

e Name the variable varMobileDevice. This variable will control which device the test
app will be started on, and therefore where the test will be run.
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e Switch to the test suite view.

6 Right-click the test suite that contains the recording with the Run mobile app action
and click Data source...

Android.ndst X

KO w2 " Data source...

ltem Drata binding / iterations
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6 In the dialog that opens, click New > Simple data table.
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Refresh
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Fill the data table with the names of the desired devices as they appear in the
endpoints pad.



TestCase properties

General Datasource Data binding Condition
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Click Data binding and under Module variable, bind the data column with the
device names to the device variable varMobileDevice.
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colMobileDevice Recordingl.varMobileDevice -

[] Recording1 warText
Recording1.varMobile Device

Aute-bind Clear bindings

Parameters Info
Mame Value Madule variable
b Add row... e

Auto-create Aute-bind Clear bindings

The test will now be iterated for each device in your data source. This will also be
reflected in your report.
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7 Ranorex

Android
Computer/Endpoint Execution time
Mexus 5X (Unknown) 30/11/2017 10:41:47 Test case result summary

USB - 00c18ccf5e6b3703

Operating system Screen dimensions

05 Language Duration

- 15.58s Bl 2x Success
Total errors Total wamings

0 0

Expand test containers Expand details Collapse all

Test container filter: ] Success [ Failed Wl Blocked

I hd E_E‘Tes‘tCase:: 5 2
I ¥ [ TestCase Datz Row: 1 8.78s
~ Test data
colMobileDevice: Nexus 5X
| + [EM Recordingl 8.73s
I ¥ [ TestCase Data Row: 2
- Test data
colMobileDevice: GT-P7500

| + [EM Recordingl 5,745

Configure a parallel cross-device test

It’s also possible to run one test on multiple devices at the same time.

o First:

o Configure a variable as in steps 1-3 in the instructions for a consecutive cross-
device test above.

o Or simply disable the existing data source if you’re working with the test from
the instructions for a consecutive cross-device test above.



TestCase properties O ot

B TestCase

General Datasource Data binding Condition

Mew | = | |Mo data source w Manage data sources..,

Mahbile_Devices - SimiIeDataCDnnectn:-r

MNo data source selected

Click 'Mew' to add a new data source

Data range
Refresh
® All rows Range

Preview effective data set...

9 In the test suite view, right-click the test suite node and click Global parameters...
9 Add a global parameter called globalMobileDevice.



Android properties O ot

" Android

General Global parameters  Report

Parameters nfo
Mame Value Module variable
globalMaobileDevice Mexus 3 (Unbound) w

b2 Add row.... e

Auto-create Aute-bind Clear bindings

Right-click the test case that contains the recording where you specified the
variable and click Data binding...
6 Under Parameters > Module variable, bind the variable to the global parameter.
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Variable binding

Data column Module variable
Aute-bind Clear bindings
Parameters Infe
Mame Value Module variable
b1 AndroidgiobaiMobileDevice Mexus 5% Recordingl.varMobileD... |~
Z Add row.... Recording1 warMabile Device

Auto-create Aute-bind Clear bindings

@ In the repository, find the app folder for your mobile app and click EDIT IN SPY.

) Addnewitern » & Track.. |3 [T [ & | % @ |Gl | TestSolutionRepository = | = Variables... ¥ Cleanup

ltem Path Comment
ComAndroidKeepass % EDITIN SPY I Base: /mobileapp[@title="com.android.keepass’] _

| Click to edit path in Spy




Modify the path as in the screenshot below and ensure the attribute devicename
has the value $varMobileDevice, i.e. the device variable specified earlier.

3% Editing 'ComAndroidKeepass'

- ELEMENT E SETTINGS.. R Studio

4 BROWSER

/mobileapp|[@title="com.android.keepass' and @devicename=SvarVobileDevice] APPLY

/mobileapp[ @title="com.android.keepass']

‘. @® TRACK ‘ |

BROWSER & RESULTS PATH EDITOR

( Refresh [G] Highlight b General

[0 mobileapp[@titie=com android keepass' and @devicename=SvarMobilel 4 MobileApp

title = o~ |com.android.keepass |
devicename EI RS varMobileDevice |v
[] deviceorientation o
[ name 5 Mexus 53X
: 7 As new variable...
[ osversion = $varMobileDevice
[] versioncode = (2 distinct values)
[] wversionname = (2 distinct values)

£ >

& One element found for current selection.

To run your test in parallel, start it from a command line environment with the
following arguments:

start MobileTest.exe /pa:globalMobileDevice="Galaxy Nexus"
start MobileTest.exe /pa:globalMobileDevice="GT-P7500"

2l
| Reference

Running tests from the command line is explained in Ranorex Studio fundamentals
> Ranorex Studio Overview > -» Run tests without Ranorex Studio

Automate Android system apps

When automating an Android App it might sometimes be necessary to leave the application
under test. For example, you want to:

o checkifanissued notification has been received


https://www.ranorex.com/help/latest/ranorex-studio-fundamentals/test-suite/running-tests-without-ranorex-studio/

e share something on a social network
e change the system settings

To automate these tasks, you need to automate the Android OS. This comes with certain
special requirements and restrictions that are explained in this chapter.

@ Note

e To automate system apps the setting ‘Android OS Automation’ has to be
enabled. The setting can be found in the mobile section of the plugin specific
settings in -»settings dialog.

e To speed up the test execution of system app automation you can disable the
generation of screenshots for android. The setting can be found in the mobile
section of the plugin specific settings in -»settings dialog.

Settings X

General | Advanced | Recorder defaults |Repositor_\,f defaults | Imaging | Plugins |

| User settings " Solution settings |

Use Java SWT legacy automation mode Falze -
Whitelisted class names

Android 05 automation
GNNECE TIMEBUT T
Deploy timeout 5m
General timeout 10m

Instrument timeout 3m
05 Maximum number of invisible children 50
Metwork discovery timeout 155

B t3 liasout L¥3

Sereenshots on AndroidQ5

Mouse Move Interpolation Mode Optimized

Evaluate computationally expensive attributes
Filter elements True
Eittac Whindosse Enrmoc alamants Ther

UIA

Restore defaults

User settings / Solution settings stored on your machine

Import... Export... oK Cancel Apply



https://www.ranorex.com/help/latest/ranorex-studio-system-details/settings-configuration/plugin-specific-settings#Mobilesolutionsetting
https://www.ranorex.com/help/latest/ranorex-studio-system-details/settings-configuration/plugin-specific-settings#Mobilesolutionsetting

Restrictions

e Toautomate system apps a USB connection has to be established.
e Highlighting on the device does not work for system apps

Validate an Issued Notification
The following example will show how to validate a text in a received notification.

Create a new recording and select the mobile option as usual. Ranorex Spy will open and you
will notice a node labeled ‘MobileApp AndroidOS’ at the application level in the object tree.

. ELEMENT N = Jr e
O RROWSER B SETTINGS... rx Studio

® TRACK |fmnhi|eapp[@title:'Android 051

BROWSER & RESULTS PATH EDITOR

o C & g&[m] LvE MobileApp ‘Android OS'
=[] MobileDevice Nexus 5X | 0,0 #1080 1734
=R Bl MobileApp Android 05
-] Container Linear'

Overview  Advanced

=] Container ‘R.id.content’ General ~
=-] Container 'R.id.la;ndcher' | Enabled True
Container 'Rid.drag_layer'
= . 82y . Valid True
= f AndroidElement 'R.id.workspace -
= g AndroidElement 'android.view.ViewGroup' Visible True
= :EI%d(r:oithl.emelnFt'lacll'ldroGid.'.'iTv.l'.Viev.'Group' MohileApp
ontainer 'Folder: Google' .
] container ‘Folder: Create' Dev?ceNa.me ) Na(us.SX
: Container 'Folder: Play' DeviceOrientation Portrait Edit path weights... b
% Text 'Play Store' o R
[ Form "android.view.View 0 MobileApp ‘Android OS* i

] Container ‘R.id.search_overlay’
=] Container'Rid.search_drop_target_bar'
= ] AndroidElement 'R.id.qsb_widget'
| -] Container'R.id.search_plate_padding_frame'
| ] Container 'R.id.search_widget_container'
=-_] Container ‘R.id.page_indicator’
| =] Container 'Frame’
| 4 Ficture Rid.inactive’
| =] Container 'Frame'
| 4 Picture Rid.active’
| =] Container 'Frame'
| g Picture Rid.inactive’
=] Container 'Rid.hotseat'
= g AndroidElement R.id.layout’
[ Form "android.view.View'
=~ 4 AndroidElement 'android.view.ViewGroup' W

Tracking OFF: Press Ctrl+LWin for instant tracking.

To navigate through the element tree you can either use the tree view. Another way to
navigate is to use the image navigator which can be found at the bottom of the
Overview/Advanced tab. Clicking a Ul element selects it, double-clicking outside the selected
element selects the parent.



To open the notification bar, a swipe action from the top of the screen has to be performed.
Navigate to a tree element including the navigation bar in the representing screenshot and
add this element to the repository using the context menu.

¥4 Ranorex Spy - (32bit) - Live

- ELEMENT B SETTINGS.. % Studio

X~ BROWSER

/mobileapp[@title="Android 08§']/?/?/container[@rid="R.id.content']/?/?/container[@rid="R.id.drag_layer']

@ TRACK

BROWSER & RESULTS PATH EDITOR

oC e -_E'u Lve Container ‘'R.id.drag_layer’
=~ [J MobileDevice 'Nexus 5X' ~ 'E:::E 0.0 ;H 1080x 1734
= [J MobileApp Android 05’ Overvi
=-_] Container 'Linear vorvion |
=1-_] Container ‘R.id.content’ General "
=] Container 'Ruid.Jauncher’ Enabled True
5 O TR Tre
=~ H AndroidEleq ] Highlight elerment
. ; T
= i Android Update element data e

B~ And|,
= L= Setelement as root ner

Add to repository erType Frame
Add to repository (incl. Children)

Edit path weights... Y]

FL  Saveassnapshat... tainer ‘R.id.drag_layer’ -

----- ] Container 'R

=] Container'Rl i@ Capture screenshot...

= Android
EE: Con Expand all
B Collapse all
=] Container'R
=] Contain Ensure visible
L@ Pict Focus
=0 ;”;ﬂg 0] SetOrientation (MobileUiElement)
F— i
-] Contain| Q] Teuch (MobileUiElement)

o | PicturE RIdNactive
-] Container R.id.hotseat’

= A AndroidElement R.id.layout’
o [T] Form ‘android.view.view'

- 4 AndroidElement ‘android view.ViewGroup' v

Tracking QFF: Press Ctrl+LWin for instant tracking.

Add a swipe action by dragging/dropping the newly created repository item to the actions
table and choosing ‘Swipe Action’ as action type from the context menu.



ValidateMNotification.mrec™ X -

RECORD " VARIABLES... | | B8 SETTINGS... Rx Studio
€ Add new action - [ & Zk Turbo mode ||fg§ Screenshot
# Action
@
Add new S Touch g the "A tion
b |"'~h Swipe gesture ms into
Mobile key press
Validation
C1 Invoke action 3
< 3 Getvalue 3 »
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[tem _ Comment || ™ container @rid="R.i...
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In the properties pane set the swipe direction to ’90°” and the start location to ‘0.5;0.0’ which
is the top center of the element.

ValidateMotification.mrec* X ~ Endpoints

— Iy

Properties

RECORD = = RUN Tm VARIABLES... | | & SETTINGS... Rx Studio

Duration 500ms

O Addnewaction~ | O & |9 Zk Turbo mode |[{gy Screenshot Enabled True

# Action Swipe dire..  Distance Swipe dura.. Repository item > Image based (None)

" Swipe gesture |D0wr| (907 ~ "500 ~ " 500ms ~ |:| RldDraglayer REpDSItDr)_r item g RidDraglayer
> IStartIocatlon 5.0 I
> Steps 0
> |Swipe direction Down (90%) |
> Swipe duration 500ms

Manually open the notification bar on your device and switch back to Ranorex Spy. Navigate
through the element tree until you’ll find the element you want to validate.
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Tracking OFF: Press Ctrl+LWin for instant tracking.

Add the specific element to the repository and add a validation action on the repository item
as described before.

Additionally, add a key press on the back button to return to the initial situation.

After adding these three actions, the recording is ready to be executed.

Test Android Wear apps

Following the instructions below you can easily create automated tests on compatible
Android Wear apps directly on real or emulated devices.

Prerequisites



o Install adb:
The Android Debug Bridge (adb) is a versatile command line tool that lets you
communicate with an emulator instance or connected Android device.
You can find it at BinRxEnvAndroidtools.

e Connect with the phone:
Download the Android Wear app on your phone and pair the watch with your phone.
You can find detailed information on how to do so
here: https://support.google.com/androidwear#topic=6056405

e Enable the debug mode:
On the smartphone go to “Developer Options” and enable “USB Debugging”.
On the watch got to “Developer Options” and enable “ADB Debugging” as well as
“Debug over Bluetooth”.

e Finally, open the Android Wear app on your smartphone, press the Settings button on
the top right and check the “Debugging over Bluetooth”. The target should be shown
as connected.

@ Note

If the target is still disconnected, try to restart both the smartphone and the
watch.

Getting Started

Connect the device via USB to your computer and call adb via command line by typing “adb
devices”.

It should print something like this:

List of devices attached
08937p69d0518aac device

This means you have successfully connected your phone to your computer. Now we need to
connect the watch too. Type the following commands:

adb forward tcp:6666 localabstract:/adb-hub
adb connect localhost:6666


https://support.google.com/androidwear#topic=6056405

@ Note

You need to accept the connection on your watch.

Type once again “adb devices”. You should now see a new device called localhost:6666:

08937p69d0518aac device
localhost:6666 device

In your Android Wear App, Host and Target should now show up as connected.

ﬁ Note

Connecting host and target does not always work at first go. Try restarting both
devices in different order and be patient.

Now you can connect your devices, instrument your apps, and create your test.
Automate on an Emulated Device

The following instructions explain how to connect a Genymotion emulated smartphone with
a Google emulated watch.

First, download Genymotion setup and start any Genymotion emulator with Android 4.3 or
later. For Google’s emulated watch you need the AVD Manager.

Start the Android Studio, go to Tools -> Android -> AVD Manager. Create a new Virtual Wear
device and start it.

Next, install Google Apps or Gapps on the Genymotion smartphone. With Gapps, also the Play
Store will be installed, which is needed for downloading the Wear App.

Go to https://opengapps.org/#downloadsection and download the correct Gapps for your
emulator. To install Gapps on Genymotion, please follow these instructions.


https://www.genymotion.com/#%21/download
http://developer.android.com/sdk/index.html
https://opengapps.org/#downloadsection
https://dzone.com/articles/installing-google-play-services-in-genymotion-emul

© Note

Gapps may sometimes be unstable when running on Genymotion emulators.

Follow the steps explained in -»Prerequisites and list your devices via adb as described
in -»>Getting started.

It should print something like this:

List of devices attached
192.168.154.102:5555 device

This means you have successfully connected your emulated phone to your computer. Now
you need to connect the watch too. Type the following command into the command line:

adb -s {genimotion ip}:{genimotion port} -d forward tcp:5601 tcp:5601

Type once again the “adb devices” command. You should see a new device called emulator-
5600.

Now you can connect your devices, instrument your apps, and create your test.

Instrumentation with source code on iOS

In this chapter, we’ll show you how to instrument your app using source code on iOS. Simply
follow the instructions below. Alternatively, there are also many video tutorials on YouTube
that detail this process.

A Attention

We recommend you only instrument with source code if you are an experienced iOS
developer.



https://www.ranorex.com/help/latest/web-mobile-testing/advanced-mobile-testing/testing-android-wear-apps/#prerequisites
https://www.ranorex.com/help/latest/web-mobile-testing/advanced-mobile-testing/testing-android-wear-apps/#TestingofAndroidWearApps-GettingStartedAndroidGettingStarted

A\ Attention

Whenever you update Ranorex Studio (i.e. use newer automation
libraries/Ranorex Service App), reinstrument your apps. Otherwise,
automation may not work as intended.

o Download the automation lib from the Mobile Download Archive on your Mac.

ﬁ Note

The file size of Ranorex Automation Library is about 30 megabytes. This does not
automatically make your app 30 megabytes bigger since it is a universal library
and only the parts essential for your app will dynamically be added when

compiling it.

9 Open the XCode project of your application under test.
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To avoid shipping an instrumented app to your customers it is recommended to
create a separate target for your app under test. You should select the project file

and duplicate the existing target.
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e Rename the newly created target.
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© Note

As XCode does not automatically update all necessary files, you have to rename
them manually. You will have to alter the target itself, the targets .plist file (in
the workspace as well as in Build Settings -> Packaging), the targets’ project

name (Build Settings -> Packaging) and the schemes name (Product -> Manage
Schemes).

6 Add the previously downloaded automation lib to your newly created target.
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After doing this, the automation lib will be listed in the ‘Linked Binary With Libraries’
listin the ‘Build Phases’ pane of the test target.
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ﬂ Note

Additionally, with iOS 8.3 add the IOKit.framework.

e In the Build Settings pane of the test, add the switches ‘-ObjC -all_load’ to the
option Other Linker Flags.
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Under the Info tab, add a Bundle display name key (CFBundleDisplayName).

@ Insert the URL schema in the application settings to open the instrumented IPA from
RxServices or Ranorex Studio, for more information review the iOS Service App page.
Below, an example of a schema:

<key>CFBundleURLTypes</key>
<array>
<dict>
<key>CFBundleTypeRole</key>
<string>Editor</string>
<key>CFBundleURLName</key>
<string>ranorex.your.application.name</string>
<key>CFBundleURLSchemes</key>
<array>
<string>ranorex.your.application.name</string>
</array>
</dict>
</array>


file:///C:/Users/Alejandra%20Barrientos/Desktop/Ale%20Barrientos/Ranorex/4.%20Web%20and%20Mobile%20Testing/ios-testing/ios-service-app/index.html

A\ Attention

If a designer implements the existing Apple API, which restricts any schema
from running the application, the instrumented IPA does not run within
RxServices and Ranorex Studio.

0 Run the RxServices IPA, put it into the background, and next, run the instrumented
IPA and put it in the background as well. This makes the application recognizable by
the RxServices IPA.

The new IPAs should display in the list of available IPAs in the RxServices application and in
Ranorex Studio.

After performing these steps, your project can be built using the newly created target and
scheme for your iOS devices as well as simulators.

© Note

If you see the debug output ‘RxAutomationEngine init‘ in the console pane,
your app has been instrumented successfully.
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ﬁ Note

e Because the Ranorex automation lib uses non-public APIs, make sure that
you do not submit a Ranorex instrumented app to the app store as your
app might be rejected and you might be banned from submitting apps to the
app store for a period of time.

e To add your device via Wi-Fi, it’s necessary that the application under test is
started on your iOS device or simulator.

e The development provisioning profile should be used for testing your app
and not the distribution provisioning profile.

e Toimprove the object recognition of your app under test set the
accessibility label attribute of your controls.

e Dueto restriction in Apple API it may occur that the instrumented IPA is not
able to run from with Ranorex Studio, while RxServices application isin the
background mode. It is recommended to perform any test while the
instrumented IPA is in the foreground.




